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Introduction 

BioExplorer is a Windows program for biophysical data acquisition, processing, and display.  It is intended for 

personal use in entertainment, education, and experimentation. 

Requirements 

 Windows 98, ME, 2000, or XP. 

 DirectX version 8.0 or later. 

 A hardware accelerated 3D graphics card is required for some displays. 

 A sound card is required for audio output.  

The minimum hardware requirements have not been determined (e.g. RAM, processor speed, etc.).  Simple 

designs should run on just about any computer capable of running Windows 98.  More complex designs may 

require more processing power. 

BioExplorer End User License Agreement (EULA)  

IMPORTANT – READ CAREFULLY  

CyberEvolution, Inc. is willing to license BioExplorer pre-release Software, and accompanying 
Documentation (collectively the "Product") only under the condition that you (either an individual or a 
single legal entity) accept all of the terms of this license agreement ("Agreement"). By purchasing, 
downloading, installing, or running the Software, you accept the terms and conditions of the Agreement. If 
you are not willing to be bound by the terms of the Agreement, do not purchase, download, install, or run 
the software.  

BioExplorer is a Windows program for real-time biophysical data acquisition, processing, and 
display.  It is intended for personal use in entertainment, education, and experimentation. 
 BioExplorer is NOT FOR MEDICAL USE and is solely for PERSONAL USE.  BioExplorer is not a 

medical product.   

Grant of License. 

Subject to the terms of this Agreement, CyberEvolution grants to Customer a limited, non-exclusive, non-
transferable license, without the right to sublicense, to install and use the Software, in object code format 

only, and the accompanying documentation solely for Customer's use.  You may not disclose to third 
parties or publish your registration details via electronic or other means.  If the terms of this license 
agreement are violated, CyberEvolution immediately terminates said license and the customer is subject 
to the liability of any harm done to CyberEvolution Inc.  

Copies. 

Customer shall not copy the Software or Documentation except for loading the Software into the computer 
memory for the purpose of executing the program. Customer may make a copy of the Software and 
Documentation for back-up purposes, provided that any such copies shall include Vendor's copyright and 
any other proprietary notices.  Customer may also make a second copy for his or her exclusive use on a 
portable or home computer.  Any copies of the Software or Documentation made by Customer are the 

exclusive property of Vendor.  



Title. 

The product is copyrighted by CyberEvolution. CyberEvolution retains all rights, title, and ownership of the 

Product and all subsequent full or partial copies and derivatives of the Product, made by you or 
CyberEvolution, including translations, compilations, partial copies, modifications, updates and know-how 
in connection there with, regardless of the form or media in or on which the same may exist. This license 
is not a sale of the Product or any copy or derivative. You shall have no right to reproduce any full or 
partial copies of the Product. You agree not to take any steps, such as reverse assembly or reverse 
compilation, to derive a source code equivalent of any software contained in the product. You also agree 
to destroy licensed data in all forms upon termination of said license or receipt of released program code.  

Warranty Exclusion. 

YOU UNDERSTAND THAT THIS PRODUCT IS A PRE-RELEASE VERSION ONLY, IS STILL UNDERGOING 
TESTING AT CYBEREVOLUTION, AND IS NOT A CYBEREVOLUTION PRODUCTION-RELEASED PRODUCT. 

 TO THE MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW, CYBEREVOLUTION AND ITS SUPPLIERS 
PROVIDE THE SOFTWARE, AND ANY (IF ANY) SUPPORT SERVICES RELATED TO THE SOFTWARE 
("SUPPORT SERVICES"), "AS IS" AND WITH ALL FAULTS, AND HEREBY DISCLAIM ALL WARRANTIES AND 
CONDITIONS, EITHER EXPRESS, IMPLIED OR STATUTORY, INCLUDING, BUT NOT LIMITED TO, ANY (IF 
ANY) IMPLIED WARRANTIES OR CONDITIONS OF MERCHANTABILITY, OF FITNESS FOR A PARTICULAR 
PURPOSE, OF LACK OF VIRUSES, OF ACCURACY OR COMPLETENESS OF RESPONSES, OF RESULTS, AND 
OF LACK OF NEGLIGENCE OR LACK OF WORKMANLIKE EFFORT, ALL WITH REGARD TO THE SOFTWARE, 

AND THE PROVISION OF OR FAILURE TO PROVIDE SUPPORT SERVICES. ALSO, THERE IS NO WARRANTY 
OR CONDITION OF TITLE, QUIET ENJOYMENT, QUIET POSSESSION, CORRESPONDENCE TO DESCRIPTION 
OR NON- INFRINGEMENT, WITH REGARD TO THE SOFTWARE. THE ENTIRE RISK AS TO THE QUALITY OF 
OR ARISING OUT OF USE OR PERFORMANCE OF THE SOFTWARE AND SUPPORT SERVICES, IF ANY, 
REMAINS WITH YOU.  

Limitation of Liability. 

TO THE MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW, IN NO EVENT SHALL CYBEREVOLUTION OR 
ITS SUPPLIERS BE LIABLE FOR ANY SPECIAL, INCIDENTAL, INDIRECT, OR CONSEQUENTIAL DAMAGES 
WHATSOEVER (INCLUDING, BUT NOT LIMITED TO, DAMAGES FOR LOSS OF PROFITS OR CONFIDENTIAL 
OR OTHER INFORMATION, FOR BUSINESS INTERRUPTION, FOR PERSONAL INJURY, FOR LOSS OF 
PRIVACY, FOR FAILURE TO MEET ANY DUTY INCLUDING OF GOOD FAITH OR OF REASONABLE CARE, FOR 
NEGLIGENCE, AND FOR ANY OTHER PECUNIARY OR OTHER LOSS WHATSOEVER) ARISING OUT OF OR IN 
ANY WAY RELATED TO THE USE OF OR INABILITY TO USE THE SOFTWARE, THE PROVISION OF OR 
FAILURE TO PROVIDE SUPPORT SERVICES, OR OTHERWISE UNDER OR IN CONNECTION WITH ANY 
PROVISION OF THIS EULA, EVEN IN THE EVENT OF THE FAULT, TORT (INCLUDING NEGLIGENCE), STRICT 
LIABILITY, BREACH OF CONTRACT OR BREACH OF WARRANTY OF CYBEREVOLUTION OR ANY SUPPLIER, 

AND EVEN IF CYBEREVOLUTION HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. BECAUSE 
SOME STATES/JURISDICTIONS DO NOT ALLOW THE EXCLUSION OR LIMITATION OF LIABILITY FOR 
CONSEQUENTIAL OR INCIDENTAL DAMAGES, THE ABOVE LIMITATION MAY NOT APPLY TO YOU.  

Proprietary Rights Exclusion. 

CyberEvolution makes no representation or warranty that the Product, or products developed using the 
Product, do not infringe any proprietary rights of any third parties. You shall assume sole responsibility for 
any such infringement.  

Indemnification. 



You hereby agree to indemnify, defend and hold CyberEvolution harmless from and against any and all 
claims, actions, suits, liabilities, judgments, losses, damages, attorneys' fees and other expenses of every 
nature and character by reason of this Agreement or use by you of products utilizing the Product.  

Export Restrictions. 

You shall not export, directly or indirectly, any Product or products developed using the Product to any 
country for which the laws of the United States or the regulations of any U.S. agency requires an export 
license or other governmental approval, without first obtaining such license or approval. You shall strictly 

comply with all such restrictions. You agree to indemnify and hold CyberEvolution harmless against all 
losses, damages, penalties, or causes of action resulting from a violation of this Section.  

U.S. Government Restricted Rights. 

This Product is provided with Restricted Rights. Use, duplication or disclosure by the Government is 
subject to restrictions as set forth in subparagraph (c)(1)(ii) of the Rights in Technical Data and Computer 
Software clause CA 252.227-7013 or subparagraphs (a) through (d) of the Commercial Computer 
Software -Restrictive Rights clause CA 52.227-19, as reserved under the copyright laws of the United 
States.  

Governing Law. 

The validity, performance, construction and interpretation of this Agreement shall be governed by laws of 
the state of Washington, United States of America.. 

What's new in this release 

 Threshold's Increase/Decrease mode can now be used to reverse the Ratio output. 

 Raised the maximum sample rate of the BrainMaster+ driver to 900 samples per second. 

 Added an option to disable the session timer sound. 

 The destination folder for auto-generated session names can now be set at startup with a command line 

argument. 

 Bug fix: a client that disconnects ungracefully (e.g. client program crashes, network connection fails, 

etc) could block the Server object from sending data to other clients. 

 Command Line Arguments 

BioExplorer recognizes the following argments:  

/AutoGenerateSessionFolder folder  

Sets the destination folder to be used when BioExplorer is configured to auto generate session file names.  

folder must be a valid, existing folder - i.e. BioExplorer will not create the folder.  

Example:  

/AutoGenerateSessionFolder c:\ProgramFiles\BioExplorer\Sessions\My Sessions 

mk:@MSITStore:C:/Program%20Files/BioExplorer/BioExplorer.chm::/Property_Pages/Binary_Threshold_Properties.htm
mk:@MSITStore:C:/Program%20Files/BioExplorer/BioExplorer.chm::/Property_Pages/Session_Timer.htm
mk:@MSITStore:C:/Program%20Files/BioExplorer/BioExplorer.chm::/Command_Line_Arguments.htm
mk:@MSITStore:C:/Program%20Files/BioExplorer/BioExplorer.chm::/Command_Line_Arguments.htm
mk:@MSITStore:C:/Program%20Files/BioExplorer/BioExplorer.chm::/Client_Interface/Overview.htm
mk:@MSITStore:C:/Program%20Files/BioExplorer/BioExplorer.chm::/Design_Objects/Server.htm


BioExplorer 

Overview 

This section gives a basic overview of BioExplorer.  

BioExplorer receives, processes, and displays data from one or more Devices.  

When BioExplorer receives data from a Device, it uses the current Design to tell it how to process and display 

that data.  

A Design is made up of a Signal Diagram, which specifies how the data is processed, and a set of Instruments, 

which are used to display the results of that processing.  

You run a Session with BioExplorer by connecting a Device, opening a Design, and pressing the Play button. 

 BioExplorer will process and display the data received from the Device in real time.  You can record a Session, 

or open a previously recorded Session for playback and analysis. 

Devices 

A device is a piece of data collection hardware.  Devices measure the analog signals of the user (e.g. skin 

conductance, EEG, EKG, etc.), digitize them, and send them to the computer. 

Designs 

Designs tells BioExplorer how to process and display the data it receives from a Device.  A Design contains a 

Signal Diagram and a set of Instruments.  

Signal Diagram 

The Signal Diagram specifies how incoming data is processed.  You create a Signal Diagram by adding Design 

Objects and wiring them together to achieve the desired result.  

In general, you need to know three things when creating a Design: 

1. The Device or Devices you want to use to capture data. 

2. How you want to process that data to extract or calculate one or more signals of interest. 

3. How you want to display those signals of interest.  

 

 

 

 

mk:@MSITStore:C:/Program%20Files/BioExplorer/BioExplorer.chm::/BioExplorer/Fundamentals/About_Devices.htm
mk:@MSITStore:C:/Program%20Files/BioExplorer/BioExplorer.chm::/BioExplorer/Fundamentals/Designs.htm
mk:@MSITStore:C:/Program%20Files/BioExplorer/BioExplorer.chm::/BioExplorer/Signal_Diagram.htm
mk:@MSITStore:C:/Program%20Files/BioExplorer/BioExplorer.chm::/BioExplorer/Instruments.htm
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Here is a relatively simple Signal Diagram:  

  

In this example, channel 1 of an Abhayamudra is used as the signal Source.  A Bandpass Filter is used to extract 

the signal of interest, which in this case are all frequency components of the signal that lie between 8 and 12Hz. 

 A Bar Graph and MIDI synthesizer are used to display the amplitude of this signal in visual and audio form.  

See Also: 

Signal Diagram Window  

Design Objects 

Design Objects are the core components of BioExplorer.  Most of the power in BioExplorer comes from the 

ability to connect Design Objects in various ways to achieve almost any result.  

Currently BioExplorer supports three classes of Design Object: Sources, Transforms, and Displays.  

Sources 

Source objects are used to get data from an external hardware device into BioExplorer.  

Transforms 

Transform objects are used manipulate and process data to extract meaningful information.  For example, the 

Bandpass Filter object can be used to remove unwanted frequency components from a signal.  The Correlation 

object can be used to determine the amount of similarity between two signals.  Transforms can be used in series 

to create arbitrarily complex Signal Diagrams.  For example, this Signal Diagram uses two Bandpass Filters and 

a Correlation object to calculate the alpha correlation between two channels (e.g. left and right hemisphere 

EEG):  

mk:@MSITStore:C:/Program%20Files/BioExplorer/BioExplorer.chm::/Design_Objects/Input.htm
mk:@MSITStore:C:/Program%20Files/BioExplorer/BioExplorer.chm::/Design_Objects/Bandpass_Filter.htm
mk:@MSITStore:C:/Program%20Files/BioExplorer/BioExplorer.chm::/Design_Objects/Bar_Graph.htm
mk:@MSITStore:C:/Program%20Files/BioExplorer/BioExplorer.chm::/Design_Objects/MIDI.htm
mk:@MSITStore:C:/Program%20Files/BioExplorer/BioExplorer.chm::/BioExplorer/Signal_Diagram.htm
mk:@MSITStore:C:/Program%20Files/BioExplorer/BioExplorer.chm::/Design_Objects/Coherence.htm


  

Displays 

Display object are used to present information about signals to the user.  Display objects typically work by 

mapping a range of input values to a display range of some type.  For example, the Bar Graph object maps a 

specific signal range to the height of a bar.  The MIDI synthesizer can map a signal range to a range of musical 

notes, so that as the input signal varies the note that the synthesizer is playing changes.  

See Also: 

Design Objects Reference  

Instruments 

Some Design Objects have user interfaces, or Instruments.  Whenever you add one of these objects to the Signal 

Diagram, its Instrument will be displayed in the Instruments window.  

See Also: 

Instruments Window 

Sessions 

You run a session with BioExplorer by pressing the Play button.  You can also record a session if you want to 

save it for analysis and review.  When you record a session, BioExplorer saves the current Design in the Session 

file as well.  When opening the Session for playback, you have the option to open that embedded design, or use 

whatever Design is currently open.  

Capture vs. Playback Mode 

BioExplorer plays sessions in either Capture or Playback mode.  When BioExplorer is in Capture mode the data 

for the Session is captured in real time by one or more hardware devices.  You can only record a Session when 

in Capture mode.  In Playback mode BioExplorer opens a previously recorded Session file and uses that data as 

its source. 

 

mk:@MSITStore:C:/Program%20Files/BioExplorer/BioExplorer.chm::/Design_Objects/Design_Object_Reference.htm
mk:@MSITStore:C:/Program%20Files/BioExplorer/BioExplorer.chm::/BioExplorer/Instruments.htm
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Statistics Export 

BioExplorer can export epoch and summary statistics while recording a session.  Statistics will only be exported 

when recording.  Epoch-based statistics include one line per epoch, which contains the statistics for that epoch. 

 Summary statistics contains one line, which indicates the statistics for the entire session as if it were one 

epoch.  

These statistics are exported as text files and are located in the same directory as the recorded session file.  They 

have the same base name as the session file, with different extensions.  The epochs file will have an extension 

of '.epochs.txt', and the summary file will have an extension of '.summary.txt'.  For example if the session file is 

text.bxs, the statistics files will be test.epochs.txt and test.summary.txt.  

Statistics files will only be generated if you have one or more signals (output ports) added to the export list. 

 You can add signals to the export list using the Signals dialog.  

All output ports that are being exported will be indicated in the Signal Diagram with a bright green color, as 

shown below:  

  

You can configure statistics export by choosing Export Settings from the Design menu.  

Statistics Export settings are saved as part of the design file.  Remember to save your design after changing 

these settings.  

See Also 

Statistics Export Settings 

Statistics Export Signals 

 

 

 

mk:@MSITStore:C:/Program%20Files/BioExplorer/BioExplorer.chm::/Property_Pages/Statistics_Export_Signals.htm
mk:@MSITStore:C:/Program%20Files/BioExplorer/BioExplorer.chm::/Property_Pages/Statistics_Export_Settings.htm
mk:@MSITStore:C:/Program%20Files/BioExplorer/BioExplorer.chm::/Property_Pages/Statistics_Export_Signals.htm


Statistics Export Settings 

 

Header 

Text entered here will be inserted before the data in the export file.  

Time, Mean, Min, Max 

Indicates which fields will be included in the export file.  

Delimiter 

Sets the delimiter to use between each value in the export file.  

Epoch 

Sets the time period used in statistics calculations.  Each 'Epoch' period a new line of data will be written to the 

statistics file, indicating the mean, min, or max over the last epoch. 

 

 

 

mk:@MSITStore:C:/Program%20Files/BioExplorer/BioExplorer.chm::/BioExplorer/Statistics_Export.htm


Statistics Export Signals 

  

This dialog allows you to specify which signals (Signal Diagram output ports) you want to include in your 

statistics export files.  

The left window displays all output ports in the Signal Diagram.  The right window indicates which signals are 

being exported.  You can add, remove, and adjust the order of exported signals using the four buttons between 

the windows. 

-> 

Adds signals selected in the left window to the list of exported signals.  

<- 

Removes selected entries from the list of exported signals.  You can also remove them by pressing the delete 

key.  

Up/Down 

Moves the selected signal up or down in the list of exported signals.  

You can change the default entries in the 'Column Name' and 'Scale' columns by selecting a cell and typing.  

The Column Name specifies the name of the column used in the exported text file.  

mk:@MSITStore:C:/Program%20Files/BioExplorer/BioExplorer.chm::/BioExplorer/Statistics_Export.htm


The Scale specifies a multiplier that can be used to scale signal values before they are exported.  For example, 

eeg amplitudes are typically in the microvolt range.  A value of 15 microvolts will be exported as 0.000015 in 

the text file.  If you want this to export as 15.0 instead, set the scale to 1,000,000. 

User Interface 

The BioExplorer User Interface is made up of the following components:  

 Main Menu 

 Control Bar 

 Status Bar 

 Signal Diagram 

 Instruments  

Each of these features is indicated below.  

mk:@MSITStore:C:/Program%20Files/BioExplorer/BioExplorer.chm::/BioExplorer/Menus/Main_Menu.htm
mk:@MSITStore:C:/Program%20Files/BioExplorer/BioExplorer.chm::/BioExplorer/Control_Bar.htm
mk:@MSITStore:C:/Program%20Files/BioExplorer/BioExplorer.chm::/BioExplorer/Status_Bar.htm
mk:@MSITStore:C:/Program%20Files/BioExplorer/BioExplorer.chm::/BioExplorer/Signal_Diagram.htm
mk:@MSITStore:C:/Program%20Files/BioExplorer/BioExplorer.chm::/BioExplorer/Instruments.htm


 

 

 

 



Main Menu 

The Main Menu is located at the top of the BioExplorer application window.  

The menus are: 

 BioExplorer 

 Session 

 Design 

 Instruments 

 Objects 

 Tools 

 Window 

 Help 

BioExplorer Menu 

Preferences... 

Devices...  

Exit 

Preferences 

BioExplorer | Preferences... 

Allows you to set program preferences. 

Devices 

BioExplorer | Devices... 

Allows you to manage the hardware devices that BioExplorer uses to capture data. 

Exit 

BioExplorer | Exit 

Exits the BioExplorer application. 

Session Menu 

Capture 

Playback...  

Play 

Record... 

mk:@MSITStore:C:/Program%20Files/BioExplorer/BioExplorer.chm::/BioExplorer/Menus/BioExplorer_Menu.htm
mk:@MSITStore:C:/Program%20Files/BioExplorer/BioExplorer.chm::/BioExplorer/Menus/Session_Menu.htm
mk:@MSITStore:C:/Program%20Files/BioExplorer/BioExplorer.chm::/BioExplorer/Menus/Signal_Diagram_Menu.htm
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Pause 

Stop  

Info... 

Capture 

Session | Capture 

Puts BioExplorer in Capture mode.  In Capture mode BioExplorer is receiving live data from your installed 

hardware devices. 

Playback 

Session | Playback... 

Opens a session file for playback. 

Play 

Session | Play 

Plays the current session if in playback mode, or begins capturing data if in capture mode. 

Record 

Session | Record... 

Starts recording data if in capture mode.  You will first be asked for a subject name and file name. 

Pause 

Session | Pause 

Pauses the current session if in playback mode, or pauses capturing data if in capture mode. 

Stop 

Session | Stop 

Stops the current session if in playback mode, or stops capturing data if in capture mode.  If recording, stops 

recording and closes the session file. 

Info 

Session | Info 
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Only available when playing back a session.  Displays the subject name, session time and date, and any notes 

that were entered when the session was recorded. 

Design Menu 

New 

Open... 

Save 

Save As... 

Add Object 

Notes 

New 

Design | New 

Creates a new design.  If you are recording, BioExplorer will ask you if you want to stop.  If the current design 

has been changed, BioExplorer will ask you if you want to save it before creating a new one. 

Open 

Design | Open 

Opens a design.  If you are recording, BioExplorer will ask you if you want to stop.  If the current design has 

been changed, BioExplorer will ask you if you want to save it before opening the new design. 

Save 

Design | Save 

Saves the current design. 

Save As 

Design | Save As 

Saves the current design under a new name. 

Add Object 

Design | Add Object... 

Allows you to add a new Design Object to the Signal Diagram. 

Notes 

Design | Notes 
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Opens the Design Notes window. 

Instruments Menu 

Edit Layout 

Snap to Edges 

Show Captions 

Make Same Width 

Make Same Height 

Make Same Size 

Background Texture... 

Instrument Texture... 

Detach 

Show Instruments 2 

Edit Layout 

Instruments | Edit Layout 

Toggles the Instruments window edit mode.  When the Instruments window is in edit mode, you can move and 

resize the Instruments.  Otherwise the Instruments are locked in place and scale proportionally with the window. 

Snap to Edges 

Instruments | Snap to Edges 

Toggles the Instruments window 'Snap' mode.  When enabled the Instruments windows will snap to the edges 

of other Instruments when being moved or resized. 

Show Captions 

Instruments | Show Captions 

Enables and disables instrument captions. 

Make Same Width 

Instruments | Make Same Width 

Makes all selected Instruments the same width as the active Instrument. 

Make Same Height 

Instruments | Make Same Height 

Makes all selected Instruments the same height as the active Instrument. 
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Make Same Size 

Instruments | Make Same Size 

Makes all selected Instruments the same size as the active Instrument. 

Background Texture 

Instruments | Background Texture 

Sets the image to be used as the Instruments window background texture. 

Instrument Texture 

Instruments | Instrument Texture 

Sets the image to be used as the Instrument frame texture. 

Detach 

Instruments | Detach 

Detaches the current Instruments window from the main application window. 

Show Instruments 2 

Instrument | Show Instruments 2 

Displays the second Instruments window. 

Objects Menu 

This menu has an entry for every object in the Signal Diagram.  Choosing one will open that object's property 

page. 

Tools Menu 

Signal Generator 

Signal Generator 

Tools | Signal Generator 

Displays the Signal Generator controls.  

Window 
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Tile Horizontally 

Tile Vertically 

Cascade 

Tile Horizontally 

Window | Tile Horizontally 

Arranges the windows by tiling them horizontally. 

Tile Horizontally 

Window | Tile Horizontally 

Arranges the windows by tiling them horizontally. 

Cascade 

Window | Cascade 

Arranges the windows by cascading them. 

Help Menu 

BioExplorer Help Topics 

BioExplorer Tutorials 

BioExplorer Online  

Check for New Version 

About BioExplorer 

BioExplorer Help Topics 

Help | BioExplorer Help Topics 

Opens the BioExplorer help file and lists the help topics. 

BioExplorer Tutorials 

Help | BioExplorer Tutorials 

Opens the BioExplorer help file and shows a list of tutorials. 

BioExplorer Online 

Help | BioExplorer Online 
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Launches a web browser and goes to the BioExplorer web site at http://www.cyberevolution.com 

Check for New Version 

Help | Check for New Version... 

Checks for a new version of BioExplorer if the computer is connected to the Internet. 

About BioExplorer 

Help | About BioExplorer 

Opens a dialog window displaying the copyright info, version, build date, and program ID. 

Control Bar 

 

 

Play 

Session | Play 

Plays the current session if in playback mode, or begins capturing data if in capture mode.  

 

Record 

Session | Record... 

Starts recording data if in capture mode.  You will first be asked for a subject name and file name.  

 

Pause 

Session | Pause 

Pauses the current session if in playback mode, or pauses capturing data if in capture mode.  

 

http://www.cyberevolution.com/


Stop 

Session | Stop 

Stops the current session if in playback mode, or stops capturing data if in capture mode.  If recording, stops 

recording and closes the session file.  

 

Seek 

Status Bar 

  

1: Mode: This is PLAYBACK or CAPTURE.  PLAYBACK indicates that BioExplorer is getting its data from 

a previously recorded session.  CAPTURE indicates the data is coming live from the hardware devices.  

2: Play State: This is PLAYING, PAUSED, or STOPPED  

3: Current Time:  In CAPTURE mode indicates how BioExplorer has been playing.  In PLAYBACK mode 

indicates the current location in the session.  

4: Total Session Time: This is only displayed in PLAYBACK mode.  Indicates the session length.  

5: Current Device Name:  Indicates which device is currently displayed in the status bar.  You can scroll 

through all currently installed devices by left clicking the mouse anywhere in field 5, 6, or 7.  

6: Current Device Connection Status:  Indicates the connection status of the current device.  This can be: 

 DISABLED: The device is currently disabled. 

 NO PORT:  BioExplorer couldn't open the specified port.  This may happen if another device is 

configured to use the same port, or if the port doesn't exist on the computer. 

 CONNECTING...:  BioExplorer has opened the port but hasn't yet established communication with the 

device.  This may happen if the device is not connected or is not turned on. 

 CONNECTED: BioExplorer is successfully communicating with the device.  

7: Extra Device Info:  This depends on the particular device.  See the Supported Devices section for more 

information. 

Signal Diagram Window 

The Signal Diagram window is used to graphically specify how to process data acquired by the devices.  
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You do this by adding Design Objects, such as a Filter or Bar Graph, and 'wiring' them together to achieve the 

desired result.  

To add an object, choose Add Object from the Design menu.  

To add a connection, left click the mouse inside an object's output port (the green circle on the right side of an 

object), and then drag the mouse to another object's input port (the blue circle on the left side of an object).  

To select objects or connections, click them with the mouse.  You can select more than one object or connection 

by holding down the CTRL key.  

To delete an object or connection, first select it and then press the DELETE key.  You can also right click it and 

choose Delete from the context menu.  

Most objects have properties that have to be set in order to achieve the desired result.  For example, you need to 

set the low and high frequencies of the Bandpass Filter to the desired passband.  To set an object's properties, 

either double click the object or right click it and choose 'Properties' from its context menu.  You can also 

choose the object from the Objects menu.  

If an object has a User Interface (UI), that UI will appear in the Instruments window when you add the object to 

the Signal Diagram.  If you delete an object with a UI, its UI will also be deleted. 

Instruments Window 

The Instruments window contains the User Interfaces (UIs) of the objects in the Signal Diagram.  
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Whenever you add an object to the Signal Diagram that has a UI (e.g. Oscilloscope, Bar Graph, etc.) that UI 

will appear in the Instruments window.  

The Instruments window has an edit mode that can be turned on and off by choosing Edit Layout from the 

Instruments menu.  

In edit mode you can arrange and size the UIs in the Instruments window.  When not in edit mode those UIs are 

locked in place and will scale proportionally as you resize the Instruments window.  

To select UIs, left click their title bar with the mouse.  You can select more than one UI by holding down the 

CTRL key.  The last UI you select is considered the 'active' UI, and will have a red border.  In the figure above 

Bar Graph 1 is the active UI.  If you select more than one UI the non-active UIs will have a green border. 

 Oscilloscope 1 is a non-active UI.  

You can use the layout helper tools under the Instruments menu (Make Same Height, etc.) to help you arrange 

the UIs.  For example, choosing Make Same Height will make all non-active UIs the same height as the active 

UI.  

To delete UIs, chose one or more and then hit delete.  You can also click on the close icon on the right side of 

the UI's title bar.  If you delete a UI its object will also be removed from the Signal Diagram.  

To set a UIs properties, right click the UI and then select Properties from the context menu.  This has the same 

effect as setting the properties of that UI's object in the Signal Diagram window.  
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Using the second Instruments Window 

You can open a second Instruments window by choosing 'Show Instruments 2' from the Instruments menu.  To 

move an object's UI from window to window, right click it and choose 'Switch Window' from the context 

menu.  

You can also 'detach' either Instruments window from the main application window, by choosing 'Detach' from 

the Instruments menu.  This allows you to easily place Instruments on a second monitor. 

Tools 

Signal Generator 

Signal Generator 

BioExplorer contains a four channel Signal Generator that can be used for testing designs.  

To use the Signal Generator in a Design:  

1. Add a Source object.  

2. Open the Source object's property page and set the Channel to one of the Signal Generator channels, as 

shown below:  

  

Each channel of the Signal Generator has two sine wave components, a DC offset component and a noise 

component.    

To control the Signal Generator, choose Signal Generator from the Tools menu.  This will open the Signal 

Generator property page.  
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See Also: 

Signal Generator Properties 

Signal Generator Properties 

  

Frequency 

Sets the frequency of the component.  

Amplitude 

Sets the amplitude of the component.  

Offset 

Sets the DC offset of the channel. 

Supported Devices 

Abhayamudra I 

Abhayamudra II 

BrainMaster 

OpenEEG 

PET - EEG 
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Roshi I 

Roshi II 

Roshi II+ 

ThoughtStream PC 

WaveRider CEO 

WaveRider jr 

WaveRider Pro 
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BioReview 

Use BioReview to calculate and view session statistics.  

BioReview allows you to create reports, which can be saved, loaded, and run on previously recorded sessions.  

Each report contains a Signal Diagram, which you use to calculate the signals of interest, and one more Views, 

which display the statistics for those signals. 

User Interface 

The BioReview User Interface is made up of the following components:  

 Main Menu 

 Signal Diagram 

 One or more Views  

Each of these features is indicated below.  
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Main Menu 

The Main Menu is located at the top of the BioReview application window.  

The menus are: 

 Report 

 Signal Diagram 

 View 

 Window 

 Help 

Report Menu 

New... 

Open 

Update Sources 

Save 

Save As... 

Run 

Run On Session... 

Preferences...  

Exit 

New 

Report | New 

Clears the current report, if any, and creates a new report.  You will be prompted for a Session to base this 

report on. 

Open 

Report | Open... 

Opens a report. 

Update Sources 

Report | Update Sources 

Updates the current report source objects from a session file.  A typical use would be to add source objects to a 

report after it has been created. 

Save 
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Report | Save 

Saves the current report. 

Save As 

Report | Save As... 

Saves the current report under a new name. 

Run 

Report | Run 

Runs the report on the currently open session. 

Run On Session 

Report | Run On Session... 

Runs the current report on a Session file. 

Preferences 

Report | Preferences... 

Allows you to set program preferences. 

Exit 

Report | Exit 

Exits the application. 

Signal Diagram Menu 

Add Object... 

Add Object 

Signal Diagram | Add Object... 

Allows you to add a new Design Object to the Signal Diagram. 

View Menu 
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New 

Add Signal... 

Properties... 

Print Epochs... 

Print Summary... 

Export... 

Cancel Zoom 

New 

View | New 

Adds a new View window to the report. 

Add Signal 

View | Add Signal... 

Allows you to add a signal from the Signal Diagram to the current View. 

Properties 

View | Properties... 

Allows you to set the properties for the current View (e.g. epoch, chart fonts and colors, etc.) 

Print Epochs 

View | Print Epochs... 

Prints the contents of the upper portion of the current View in either chart or table format, depending on which 

format is selected. 

Print Summary 

View | Print Summary... 

Prints the contents of the lower portion of the current View, the summary statistics. 

Export 

View | Export... 

Allows you to export the statistics or raw data of the signals contained in the current view. 

Cancel Zoom 
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View | Cancel Zoom 

Resets the time span of the current view to the duration of the entire session.  Also resets the chart axis so that 

all data can be displayed. 

Window Menu 

Tile Horizontally 

Tile Vertically 

Cascade 

Tile Horizontally 

Window | Tile Horizontally 

Arranges the windows by tiling them horizontally. 

Tile Vertically 

Windows | Tile Vertically 

Arranges the windows by tiling them vertically. 

Cascade 

Window | Cascade 

Arranges the windows by cascading them. 

Help Menu 

About BioReview 

About BioReview 

Help | About BioReview 

Opens a dialog window displaying the copyright info, version, build date, and program ID. 

Signal Diagram Window 

The Signal Diagram window in BioReview is used to graphically specify the signals you want to use in your 

report.  
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For example, the Signal Diagram above will calculate the alpha signal, amplitude, and coherence for two EEG 

channels.  Unlike the Signal Diagram in BioExplorer, you can only add Transform objects the BioReview's 

Signal Diagram. 

View Window 

The View window displays summary and epoch statistics for one or more signals.  
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The lower portion of the window displays summary statistics for each signal, calculated over the current time 

span.  The upper portion of the window displays the mean value over each epoch for each signal, in either chart 

or table format.  

Time Span 

You can change the start time, end time, and epoch length by choosing Properties from the View menu.  You 

can also change the time span by left clicking the mouse in the Chart and dragging it over the desired time span 

and amplitude range.  To return to the original full-session time span, choose 'Cancel Zoom' from the View 

menu.  

Adding Signals 

You can add a signal to the current view by choosing Add Signal from the View menu.  Statistics will not be 

displayed for newly added signals until you run the report on a session, by choosing 'Run' or 'Run on Session' 

from the Report menu.  

Removing Signals 

Remove a signal by selecting it in the Signal column with the mouse.  This will select the entire row.  Then 

press the Delete key to remove the signal.  

Changing the Signal Order 

You can change the order of the signals using the Table view.  Select the Table tab, and then simply drag the 

signal where you want it by clicking its column header and dragging with the mouse.  

Display Name 

You can set the display name for any signal by typing it into the Name column.  The display name is used by 

the chart legend (if enabled) and the table view.  It is also used to identify each signal when exporting data.  

Threshold 

You can set the threshold for each signal by typing it into the Threshold column.  BioReview will report the 

percentage of samples that are over and under this threshold over the current time span.  

Scale 

You can set a scale, or multiplier for each signal by entering it into the Scale column.  This can be useful if you 

want to view signals with different ranges on the same chart.  Exported statistics are also scaled by this value.  

Enable/Disable Chart 

You can set whether or not a signal is displayed in the Chart using the checkbox in the Chart column.  
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Color 

Use this column to set the Chart color for each signal. 



Design Object Reference 

AND 

Calculates the logical AND of its input signals.  If all input signals are not 0.0, the output will be 1.0, otherwise 

the output will be 0.0. 

Audio Player 

Plays audio files - mp3, wma, wav, etc.  Volume and Enable can be controlled from the Signal Diagram.  

See Also: 

Audio Player Playlist 

Audio Player Settings 

Audio Player Volume Properties 

Audio Player Playlist 

  

Use this dialog to create a playlist for the Audio Player.  
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The red X next to the second item above indicates that the file cannot be found.  This can happen when moving 

a design to a new computer.  If this is the case either copy the missing file to the specified location, or delete the 

entry and add a new file.  

Add 

Opens a file selection dialog you can use to choose audio files.  

Remove 

Removes all selected files from the playlist.  

Move Up 

Moves the selected file up in the play order.  

Move Down 

Moves the selected file down in the play order. 

Audio Player Settings 

  

Volume 
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Specifies the player volume when no connection is made to the object's Volume input.  

Repeat 

If selected, the player will replay the playlist when it finishes.  

Restart On Trigger 

If selected, the player will restart the currently playing audio file if a trigger input is received before it 

completes.  If not selected the trigger input will be ignored until the currently playing audio file completes.  

Audio Output 

Selects the audio output device (soundcard) for this Audio Player.  In most cases this should be set to "Default." 

 When set to "Default" the Audio Player will use the default soundcard as configured in Windows. 

Audio Player Volume Properties 

  

Use this dialog to control how a signal connected to the object's Volume input is mapped to a volume level.  In 

the figure above an input of 0.0 would map to zero volume, and an input of 60.0u would map to full volume.  

Signal 

Indicates the object and port that are connected to the player's Volume input.  
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Auto Range 

When enabled, the player will automatically adjust its Input Range based on the variations of the input signal.  

Period 

Sets the time period for the Auto Range calculation.  For example a setting of 30.0 means the Input Range will 

be set based on the variations of the input over the last 30 seconds.  

Input Range and Volume Range 

Specifies how input signals are mapped to a volume range.  

Average Period 

The period of time over which the input signal is averaged.  This average value is then used to set the volume. 

 Range is from 0.0 to 10.0 seconds.  

Average 

Calculates the average value of a signal over a specified period of time, or over the total time.  The output is 

recalculated every time an input sample is received.  

This object will be reset when the play state becomes stopped, or on a low to high (zero to non-zero) transition 

on the Reset input. 

Average Properties 

  

Moving 

mk:@MSITStore:C:/Program%20Files/BioExplorer/BioExplorer.chm::/Design_Objects/Averager.htm


Calculates the moving average over the Average Period.  

Total 

Calculates the total average from the last stop to play transition, or from the last Reset input.  

Average Period 

The length of time over which input samples are averaged. 

Band Ratio 

Calculates the ratio between the amplitude or power in two frequency bands. 

Band Ratio Properties 

  

Band 1 Frequency Range 

Specifies the frequency range for Band 1.  

Band 2 Frequency Range 

Specifies the frequency range for Band 2.  

All 
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When checked, sets Band 2 to the entire frequency spectrum, and the output becomes the percent power or 

amplitude in Band 1.  

Power 

Calculates the ratio of the power in Band1 and Band2.  

Amplitude 

Calculates the ratio of the amplitude in Band1 and Band2.  

FFT Bins 

Sets the number of bins or frequency components the FFT will calculate.  More bins give a greater frequency 

resolution but increase the response time.  

Resolution 

Displays the current frequency resolution.  

Bandpass Filter 

Filters a signal, allowing frequency components that are between the low band edge and the high band edge to 

pass through, and attenuating components outside this range.  Also calculates the amplitude of the filtered 

signal.  

Outputs 

 Signal: The filtered signal 

 Amplitude: The amplitude of the filtered signal 

 

 

 

 

 

 



Bandpass Filter Properties 

 

Use this dialog to specify the filter's characteristics.  

Low 

The lower edge of the filter passband.  

High 

The upper edge of the filter passband.  

Offset 

Adjusts the passband up or down in 0.1Hz increments.  

FIR 

The filter will be implemented with a FIR filter.  

Butterworth IIR 

The filter will be implemented with a Butterworth IIR filter.  

Chebyshev IIR 

The filter will be implemented with a Chebyshev IIR filter.  
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Elliptic IIR 

The filter will be implemented with an Elliptic IIR filter.  

Order/Length 

The filter order or length.  Typically, IIR filters are specified in terms of their order, and FIR filter in terms of 

their length.  Higher orders or lengths better attenuate signals outside the passband.  The tradeoff is that the 

delay the filter imposes on the signal becomes greater as the order or length goes up.  

Ripple 

Maximum allowable filter ripple, in dB.  

Attenuation 

Desired out-of-band attenuation, in dB.  

Quick Set 

These controls allow you to quickly set a passband.  You can modify the passband of each button, change the 

name of any button, and add additional passbands to the Custom list by pressing the ... button.  

Magnitude and Delay graphs 

These graphs display the Magnitude and Delay response of the filter over its passband. 

Bar Graph 

The Bar Graph object is used to visually indicate the value of a signal.  

  



The Bar Graph will also display threshold information when connected to the Signal output of a Threshold 

object.  In the above Bar Graph the horizontal bar indicates a threshold of 30u. 

Bar Graph Properties 

  

Signal 

Indicates the object and port that are connected to the Bar Graph's input.  

Auto Range 

When enabled, the Bar Graph will automatically adjust its Display Range based on the variations of the input 

signal.  

Period 

Sets the time period for the Auto Range calculation.  For example a setting of 30.0 means the Input Range will 

be set based on the variations of the input over the last 30 seconds.  

Display Range 

The range displayed by the Bar Graph.  For example, if the range is 10u - 20u, 10u would correspond to the 

bottom of the display and 20u would correspond to the top of the display.  

Average Period 
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The period of time over which the input signal is averaged.  This average value is then used to set the bar 

height.  Range is from 0.0 to 10.0 seconds.  

Refresh Period 

The period at which the display is updated, or redrawn.  Range is from 10.0mS to 10.0 seconds.  

Show Header 

Turns on the Bar Graph scale header.  

Show Label 

Enables labeling the Bar Graph with the object and output port that are being monitored.  

Show Object Name 

Includes the name of the object that this channel is monitoring in the label.  

Bar Color 

Sets the bar color.  

Background Color 

Sets the background color.  

Button 

The Button object outputs 0.0 when not pressed and 1.0 when pressed.  

  

The button label can be changed, and the type can be set to momentary or toggle. 

 

 

 

 



Button Properties 

  

Up Caption 

Sets the button text in the inactive (up) state.  

Down Caption 

Sets the button text in the active (down) state.  Only used when the button type is Toggle.  

Momentary 

The button will remain down as long as it is being pressed by the mouse.  

Toggle 

Clicking the button will toggle it between the up and down state.  

CD Player 

Plays CD audio.  Volume and Enable can be controlled from the Signal Diagram. 

 

 

 

mk:@MSITStore:C:/Program%20Files/BioExplorer/BioExplorer.chm::/Design_Objects/Button.htm


CD Player Tracks Properties 

  

Use this dialog to select the CD drive and tracks.  Only tracks that are checked will be played.  

Drive 

Use this to select which CD drive the player will use.  

Refresh 

This button refreshes the track list.  This may be necessary if you change the CD while this dialog is open  

Select All 

Selects all tracks in the list  

Clear All 

Unselects all tracks in the list 
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CD Player Settings 

  

Volume 

Specifies the player volume when no connection is made to the player's Volume input.  

Repeat 

If selected, the player will replay the selected tracks when it finishes. 
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CD Player Volume Properties 

 

Use this dialog to control how a signal connected to the object's Volume input is mapped to a volume level.  In 

the figure above an input of 0.0 would map to a volume of 10, and an input of 60.0u would map to full volume.  

Signal 

Indicates the object and port that are connected to the player's Volume input.  

Auto Range 

When enabled, the player will automatically adjust its Input Range based on the variations of the input signal.  

Period 

Sets the time period for the Auto Range calculation.  For example a setting of 30.0 means the Input Range will 

be set based on the variations of the input over the last 30 seconds.  

Input Range and Volume Range 
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Specifies how input signals are mapped to a volume range.  

Average Period 

The period of time over which the input signal is averaged.  This average value is then used to set the volume. 

Range is from 0.0 to 10.0 seconds.  

Coherence 

Calculates the coherence and phase difference of two signals within a specified bandwidth.  Coherence varies 

between 0.0 and 1.0, with 0.0 indicating no coherence.  Phase Difference varies from -180 to 180 degrees, with 

positive values indicating that the signal on In1 is leading the signal on In2. 

Coherence Filter Properties 

  

Use this dialog to specify the coherence filter's characteristics.  

Low 

The lower edge of the filter passband.  

High 

The upper edge of the filter passband.  
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Offset 

Adjusts the passband up or down in 0.1Hz increments.  

FIR 

The filter will be implemented with a FIR filter.  

Butterworth IIR 

The filter will be implemented with a Butterworth IIR filter.  

Chebyshev IIR 

The filter will be implemented with a Chebyshev IIR filter.  

Elliptic IIR 

The filter will be implemented with an Elliptic IIR filter.  

Order/Length 

The filter order or length.  Typically, IIR filters are specified in terms of their order, and FIR filter in terms of 

their length.  Higher orders or lengths better attenuate signals outside the passband.  The tradeoff is that the 

delay the filter imposes on the signal becomes greater as the order or length goes up.  

Ripple 

Maximum allowable filter ripple, in dB.  

Attenuation 

Desired out-of-band attenuation, in dB.  

Quick Set 

These controls allow you to quickly set a passband.  You can modify the passband of each button, change the 

name of any button, and add additional passbands to the Custom list by pressing the ... button.  

Magnitude and Delay graphs 

These graphs display the Magnitude and Delay response of the filter over its passband. 

Continuous MIDI 

Plays a continuous MIDI note when Enabled.  The Volume and Pitch of the note can be controlled from the 

Signal Diagram. 



Continuous MIDI Settings 

  

Device 

Selects the MIDI synthesizer device to be used by this object.  If this value is set to 'Default', the device 

specified in the Audio Preferences dialog will be used.  

Instrument 

Selects the MIDI instrument to use when playing notes.  

Note 

Specifies the note to play when no connection is made to the Note input.  

Volume 

Specifies the note volume when no connection is made to the Volume input.  

Play Continuously 

When checked, this object will play a note even if no connections are made to its input ports.  

Channels 

Specifies the audio channel the object will use to play notes. 
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Continuous MIDI Pitch Properties 

  

Use this dialog to control how a signal connected to the object's Pitch input alters, or bends the note pitch.  

Signal 

Indicates the object and port that are connected to the object's Pitch input.  

Auto Range 

When enabled, the object will automatically adjust its Input Range based on the variations of the input signal.  

Period 

Sets the time period for the Auto Range calculation.  For example a setting of 30.0 means the Input Range will 

be set based on the variations of the input over the last 30 seconds.  

Input Range 

Specifies how input signals are mapped to a pitch.  An input signal that lies in the middle of the input range 

(30u in the figure above), will not bend the pitch at all.  An input of 0.0 will bend it down by 10% (the Pitch 

Bend value), and an input of 60.0u will bend it up by 10%.  

Pitch Bend 

Specifies how far to bend the pitch, based on the input signal.  This value ranges from 0 to 100.  The actual 

amount that the pitch will change varies from soundcard to soundcard, but typically a bend of 100 equals two 

octaves.  
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Average Period 

The period of time over which the input signal is averaged.  This average value is then used to set the pitch. 

Range is from 0.0 to 10.0 seconds. 

Continuous MIDI Volume Properties 

  

Use this dialog to control how a signal connected to the object's Volume input is mapped to a volume level.  In 

the figure above an input of 0.0 would map to a volume of 30, and an input of 60.0u would map to full volume.  

Signal 

Indicates the object and port that are connected to the object's Volume input.  

Auto Range 

When enabled, the player will automatically adjust its Input Range based on the variations of the input signal.  

Period 

Sets the time period for the Auto Range calculation.  For example a setting of 30.0 means the Input Range will 

be set based on the variations of the input over the last 30 seconds.  

Input Range and Volume Range 

Specifies how input signals are mapped to a volume range.  

Average Period 
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The period of time over which the input signal is averaged.  This average value is then used to set the volume. 

Range is from 0.0 to 10.0 seconds. 

Correlation 

Calculates the correlation of two signals using Pearson’s Product Moment.  The output ranges from –1.0 to 1.0. 

 An output of –1.0 indicates a perfect negative correlation,  an output of 0.0 indicates no correlation, and an 

output of 1.0 indicates a perfect positive correlation between input signals.  The output is updated every time an 

input sample is received by the input signal having the highest sample rate. 

Correlation Properties 

  

Correlation Period 

The period of time over which the correlation is calculated. 

Counter 

Counts properties of a signal: 

 Rising Edges 

 Falling Edges 

 Time High 

 Time Low  

Also provides a Trigger output that transitions from 0.0 to 1.0 whenever the count increments by a specified 

amount.  For example, this output can be used to trigger a MIDI note whenever the count increments by 1. 
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Counter Properties 

  

Rising Edge 

Counts number of rising edges on the input signal (transition from 0.0 to greater than 0.0).  

Falling Edge 

Counts number of falling edges on the input signal (transition greater than 0.0 to 0.0).  

Time High 

Counts time that the input signal is high (greater than 0.0).  

Time Low 

Counts time that the input signal is low (equals 0.0).  

Trigger Every 

This value sets how often the Trigger output is pulsed from low to high (0.0 to 1.0).  For example if set to 5.0, 

the Trigger output will pulse when the count crosses 5.0, 10.0, 15.0, etc. 

Difference 

Calculates the difference between the current input sample and the previous input sample.  The output is 

positive if the input is increasing, and negative if the input is decreasing.  

Dominant Frequency 
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Calculates the dominant frequency (i.e. the frequency component with the largest amplitude) of a signal.  Also 

calculates the amplitude at the frequency, using an FFT. 

Dominant Frequency Properties 

  

Use this dialog to specify the frequency range of interest, and the frequency resolution.  

Min Frequency 

The lowest frequency to evaluate when determining the dominant frequency.  Frequency components lower 

than this frequency will be ignored.  

Max Frequency 

The highest frequency to evaluate when determining the dominant frequency.  Frequency components higher 

than this will be ignored.  

FFT Bins 

Sets the number of bins or frequency components the FFT will calculate.  More bins give a greater frequency 

resolution but increase the response time.  

Resolution 

Displays the current frequency resolution. 
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DVD Decoders 

  

Use this dialog to view the available decoders installed on your computer, and to select which decoders are used 

by the DVD Player object.  

An empty decoder list indicates that no compatible decoders were found on your computer.  A partial list of 

decoder suppliers can be found here.  

You must select both an audio and video decoder.  The Navigator property is disabled in this version, and the 

default value is always selected.  

DVD Player 

Plays DVD video.  Volume, Enable (play/pause), Size, and Brightness level can be controlled from the Signal 

Diagram. 
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Menu Button 

Displays the DVD menu.  The DVD Player supports on-screen navigation of the displayed menu using the 

mouse.  

Control Button 

When this button is pressed, signals from the player's Volume, Enable, Brightness, and Size inputs are used to 

control DVD playback.  Otherwise these input signals are ignored.  Turning off input control is useful when 

navigating the DVD with the on-screen menu.  Pressing the Menu button will automatically turn off input 

control.  

Full Button 

Switches the player to full screen mode.  Press Alt + Tab to exit full screen mode.  

Unlike the other player objects in BioExplorer, the DVD Player has independent Play/Pause/Stop control from 

its user interface.  This is due to the relatively long time it takes to set up a DVD (navigating the menu, selecting 

a chapter, etc.).  For example, you might want to record more than one session while running a DVD. 

Independent play control allows you to stop the session without restarting the DVD.  

DVD Playback is demanding in terms of CPU resources and may adversely impact the response time of 

BioExplorer, depending on the system.  Factors that effect response time are CPU speed, video card 

acceleration of DVD decoding, and system memory.  Newer machines that have a CPU speed of at least 1GHz, 

128MB of memory, and a relatively fast video card should work well.  Windows should be configured to use 

the maximum hardware acceleration of the video card.  



DVD Decoders 

DVD Playback requires audio and video DVD decoders installed in Windows.  Like Microsoft’s Media Player, 

CyberEvolution does not supply DVD decoders due to licensing issues.  

Decoders are available from several third parties.  Many DVD player applications include compatible decoders 

(e.g. WinDVD, PowerDVD, etc).  You can find links to some of these providers here.  

Configuring the Player 

Before you can use the DVD Player, you must select an audio and video decoder.  You can view the available 

decoders on your machine by choosing Preferences from the BioExplorer menu, and selecting the DVD 

Decoders tab.  Please the DVD Decoders help topic for more information.  

Brightness, Size, and Dual Monitors 

The Video Mixing Renderer (VMR) is required to use Size and Brightness control.  It is also required to play 

video on a second monitor in most cases.  The DVD Player object will automatically attempt to use the VMR. 

VMR availability is indicated in the DVD Player status bar, as shown above.  If "VMR off" is displayed in the 

status bar, you will not be able to use the Brightness and Size features of the DVD Player.  

If the player can't enable the VMR (i.e. "VMR off" is displayed in the status bar), the most likely problems are 

an underpowered video card or a DVD video decoder that doesn't support VMR.  Older DVD decoders 

typically do not support VMR, so make sure you're using an up-to-date version.  

Known Issues  

When inserting a DVD into the drive, you may have to wait several seconds for the drive to spin up before you 

can play it in BioExplorer.  After it spins up, Windows may automatically launch an external player 

(PowerDVD, etc) or some type of installation routine.  If this happens, close the launched application and return 

to BioExplorer. 
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DVD Player Settings 

  

Volume 

Set the player volume when no connection is made to the Volume input.  

Brightness 

Sets the player video brightness when no connection is made to the Brightness input.  

Size 

Sets the player video size when no connection is made to the Size input.  

Background Color 

Sets the background color of the video display area. 
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DVD Player Volume Properties 

  

Use this dialog to control how a signal connected to the player's Volume input is mapped to a volume level.  In 

the figure above an input of 0.0 would map to a volume of 0, and an input of 50.0u would map to full volume.  

Signal 

Indicates the object and port that are connected to the player's Volume input.  

Auto Range 

When enabled, the player will automatically adjust its Input Range based on the variations of the input signal.  

Period 

Sets the time period for the Auto Range calculation.  For example a setting of 30.0 means the Input Range will 

be set based on the variations of the input over the last 30 seconds.  

Input Range and Volume Range 

Specifies how input signals are mapped to a volume range.  

Average Period 

The period of time over which the input signal is averaged.  This average value is then used to set the volume. 

Range is from 0.0 to 10.0 seconds. 
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DVD Player Brightness Properties 

  

Use this dialog to specify how a signal connected to the player's Brightness input controls the video brightness.  

Signal 

Indicates the object and port that are connected to the player's Position input.  

Auto Range 

When enabled, the player will automatically adjust its Input Range based on the variations of the input signal.  

Period 

Sets the time period for the Auto Range calculation.  For example a setting of 30.0 means the Input Range will 

be set based on the variations of the input over the last 30 seconds.  

Input Range and Brightness Range 

Specifies how input signals are mapped to a brightness level.  An input value between the minimum and 

maximum Input Range will be linearly mapped to a brightness level.  The maximum brightness level is 1.0.  

Average Period 

The period of time over which the input signal is averaged.  This average value is then used to set the 

brightness.  Range is from 0.0 to 10.0 seconds. 
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DVD Player Size Properties 

  

Use this dialog to specify how a signal connected to the player's Size input controls the video size.  

Signal 

Indicates the object and port that are connected to the player's Size input.  

Auto Range 

When enabled, the player will automatically adjust its Input Range based on the variations of the input signal.  

Period 

Sets the time period for the Auto Range calculation.  For example a setting of 30.0 means the Input Range will 

be set based on the variations of the input over the last 30 seconds.  

Input Range and Size Range 

Specifies how input signals are mapped to a size.  An input value between the minimum and maximum Input 

Range will be linearly mapped to a size.  The maximum size is 1.0.  

Average Period 

mk:@MSITStore:C:/Program%20Files/BioExplorer/BioExplorer.chm::/Design_Objects/DVD_Player.htm


The period of time over which the input signal is averaged.  This average value is then used to set the size. 

Range is from 0.0 to 10.0 seconds.  

 

Expression Evaluator 

Uses a user-defined expression to calculate the output based on one or more input signals.  For example, the 

expression “In1 / In2” calculates the ratio of input signal In1 to input signal In2.  The output is updated every 

time an input sample is received by the input signal having the highest sample rate. 

Expression Evaluator Properties 

  

Expression 

The expression used to calculate the output.  Constants used in expressions can have a ‘units’ suffix (e.g. 10K = 

10000, 15u = 0.000015).  Recognized ‘units’ suffixes are: 

 K = 1,000 

 m = 0.001 

 u = 0.000001 

 n = 0.000000001  

Samples received on the input ports are referenced using the variables In1, In2, etc in your expression.  The 

previous calculation's inputs and result are also available using the variables LastIn1, LastIn2, etc. and 

LastResult.  

Example expressions 
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 if((In1>In2), 0.0, 10.0u)  If In1 is greater than In2 the output is 0.0, otherwise the output is 10.0u 

(0.00001). 

 if((In1>=In2), In3, In4)  If In1 is greater than or equal to In2 the output is In3, otherwise the output is 

In4. 

 In1=In2  If In1 equals In2 the output is 1.0, otherwise the output is 0.0 

 max(In1, In2)  If In1 = 0.1 and In2 = 0.8, the output is 0.8 

 (In1<20u) & (In2>=10u)  If In1 is less than 20u and In2 is greater than or equal to 10u the output is 1.0, 

otherwise the output is 0.0  

Predefined Variables  

LastIn1, LastIn2, etc: The previous input sample for inputs In1, In2, etc. 

LastResult: The previous output sample. 

SampleRate1, SampleRate2, etc: The sample rate for inputs In1, In2, etc. 

Time: The current session time in seconds.  

Supported Functions and Operators 

  

Symbol Equivalent Description Example 

()   Prioritizes an expression In1 * (In2 + In3) 

%   Percentage 35% = 0.35 

^   Raised to the power of In1 ^ In2 

*   Multiply by In1 * In2 

/   Divide by In1 / In2 

\   Integer divide by In1 \ In2 

MOD   Integer Modulo (remainder) MOD(In1, 5) 

FMOD   Floating point remainder FMOD(In1, 5.5) 

+   Add In1 + In2 

-   Subtract In1 - In2 

>   Greater than In1 > In2 

<   Less than In1 < In2 

= == Equal test In1 == In2 

>=   Greater or equal In1 >= In2 

<=   Less or equal In1 <= In2 

<>   Not equal In1 <> 5.5 

&   Logical AND In1 & In2 

|   Logical OR (In1 > 0) | (In2 < 10u) 

!   Logical NOT !In1 

IF   If condition IF((In1 > In2), 0, 10) 



MIN   Minimum value min(In1, In2) 

MAX   Maximum value max(In1, In2) 

SIN   Sine sin(In1) 

COS   Cosine   

TAN   Tangent   

ASIN   Arc Sine   

ACOS   Arc Cos   

ATAN   Arc Tangent   

COT   Cotangent   

SINH   Hyperbolic Sine   

COSH   Hyperbolic Cosine   

TANH   Hyperbolic Tangent   

ABS   Absolute Value abs(In1) 

EXP   to the power of exp(In1) 

POW   value raised to power of pow(In1, 5) 

LN   Natural Log log(In1) 

LOG   Log base 10   

CEIL   Round Up ceil(In1) 

FLOOR   Round Down floor(In1) 

RND   Integer Random Number rnd(1) 

INT   Truncate to an integer int(In1) 

TRUNC   Truncate to an integer, same as INT function trunc(In1) 

SGN   Sign of Expression (-1, 0, or 1) sgn(In1) 

SQR   Square (x * x) sqr(In1) 

SQRT   Square Root sqr(In2) 

Filter Properties 



 

Use this dialog to specify the filter's characteristics.  

Cutoff Frequency 

Sets the filter's cutoff frequency.  Signal components above or below this frequency will be attenuated, 

depending on the Selectivity setting.  

Offset 

Adjusts the cutoff frequency up or down in 0.1Hz increments.  

FIR 

The filter will be implemented with a FIR filter.  

Butterworth IIR 

The filter will be implemented with a Butterworth IIR filter.  

Chebyshev IIR 

The filter will be implemented with a Chebyshev IIR filter.  

Elliptic IIR 

The filter will be implemented with an Elliptic IIR filter.  



Order/Length 

The filter order or length.  Typically, IIR filters are specified in terms of their order, and FIR filter in terms of 

their length.  Higher orders or lengths better attenuate signals outside the passband.  The tradeoff is that the 

delay the filter imposes on the signal becomes greater as the order or length goes up.  

Ripple 

Maximum allowable filter ripple, in dB.  

Attenuation 

Desired out-of-band attenuation, in dB.  

Lowpass 

The filter will attenuate signal components above the cutoff frequency.  

Highpass 

The filter will attenuate signal components below the cutoff frequency.  

Magnitude graph 

Displays the magnitude response of the filter.  

Width 

Sets the width or frequency range of the magnitude graph, centered on the cutoff frequency. 

Flash Player 

This object plays content and programs developed for the Macromedia Flash player.  The content can be 

programmed to use data from the Signal Diagram.  

Two sample "games" are provided in the Flash folder (e.g. c:\Program Files\BioExplorer\Flash).  



  

PacMan.swf, used in the example design FlashPacMan.bxd: This game uses the In1 port of the Flash Player 

object.  Whenever the signal value on port In1 is non-zero, the character will move.  The counters at the bottom 

of the display indicate the score and elapsed time. 

  

  

Boxes.swf, used in the example design FlashBoxes.bxd:  This program uses the values on ports In1 - In3 to 

control box size.  When the input value is 1.0 the colored box will be the same size as the border box.  This can 

be used with the Ratio output of the Threshold object to indicate over/under threshold conditions.  The value 



received on In4 is displayed in the score text box at the top of the display.  In FlashBoxes.bxd this value is the 

total time that all threshold conditions are met.  

Boxes.fla, the source code for this program, is also included in the Flash folder.  This program can be opened 

and modified in Macromedia's Flash development tool.  The source code provides an example of how signal 

data can be used in a Flash program.  

Developing content for the Flash Player object 

Macromedia provides development tools and documentation that can be used to create Flash player content.  

www.macromedia.com  

Using BioExplorer signal data in your Flash program 

The following assumes the reader is familiar with Flash and ActionScript programming.  

The current signal value on any of the Flash Player object's input ports is accessible using ActionScript.  A 

variable is created for each input port, with the same name as that port (e.g. In1, In2, etc).  These variables are 

accessible from the root movie clip object in your Flash program.  

At this time there is no synchronization between the setting of variables from within BioExplorer, and the 

reading of these variable using ActionScript.  BioExplorer sets the variable every time a new value is received 

on a Flash Player object's input port (typically 128 times a second or more), and Action Script uses that variable 

value asynchronously, whenever it's accessed within the Flash program.  In most cases this will be once per 

animation frame, or about 30 times a second. 

This model works well when using Flash to provide some type of visual or game feedback driven by the signal 

values, as in the example programs above.  If the screen is updated 30 times a second, there's no need to use the 

values that arrive between frames.  However, you can't do complex calculations from within your Flash 

program that require every sample value (e.g. correlation, filtering, etc).  

Max 

The output will be the maximum value received over all input samples.  This object will be reset when the play 

state becomes stopped, or on a low to high (zero to non-zero) transition on the Reset input. 

Mean Frequency 

Calculates the mean frequency, or center of mass of a specified frequency band using an FFT. 

Mean Frequency Settings 

http://www.macromedia.com/
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Use this dialog to specify the frequency range of interest.  Frequency components outside of this range will be 

ignored when calculating the mean frequency. 

Meter 

The Meter object is used to display the value of a signal in numeric format.  

  

The Meter will also display threshold information when connected to the Signal output of a Threshold object. 

The Meter above indicates a threshold of greater than 5.0u and less than 20.0u.  

When the threshold condition is not met the display will dim. 

Meter Properties 
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Signal 

Indicates the object and port that are connected to the Meter's input.  

Refresh Period 

The period at which the display is updated, or redrawn.  Range is from 10.0mS to 10.0 seconds.  

Average Period 

The period of time over which the input signal is averaged.  This average is the value displayed by the meter. 

 Range is from 0.0 to 10.0 seconds.  

Decimal Places 

The number of digits to display after the decimal point.  

No Formatting 

Displays the value with no formatting.  



Percentage Format 

Formats the displayed value as a percentage.  For example an input of 0.85 will display as '85%'.  

Time Format 

Time format interprets the input as seconds, and displays the value in time format (e.g. 01:23:17).  

Show Hours 

Includes hours in the display.  Only used when in time format.  

Show Hundredths 

Includes hundredths of a second in the display.  Only used when in time format.  

Auto Range 

When selected, the meter will adjust its scale based on the input.  For example 0.01 will display as 10m, and 

0.00001 will display as 10u.  

Fixed Scale 

When Auto Range is not selected you can pick a fixed scale for the meter.  This can be useful if you know the 

expected input range of your signal.  For example when viewing an EEG signal's amplitude, selecting a fixed 

scale of micro (u) will keep the Meter from dropping down into nanovolts if the input falls below 1 microvolt.  

Show Labels 

Enables labeling the meter with the object and output port that are being monitored.  

Show Object Name 

Includes the name of the object that this channel is monitoring in the label.  

Display Color 

Sets the display color.  

Background Color 

Sets the background color. 

MIDI 

This object uses your computer's MIDI synthesizer to play musical notes.  The volume, note, and timing can be 

controlled from the Signal Diagram.  



The Enable input controls whether or not notes can be played.  If the Enable input is 0.0, no notes will be 

played.  Otherwise notes will be played.  

The Trigger input is used to control when a note is played.  If no connection is made to the Trigger input, notes 

will play at the rate specified in the Timing property page.  Otherwise a note will be played whenever the 

Trigger input transitions from 0.0 to some other value.  Typical uses might be to connect this input to the 

Pass/Fail output of a Threshold, the Trigger output of a Counter, or the Trigger output of a Pulse Detector.  

To configure the MIDI object to play a note only when a threshold condition is met, connect the Pass/Fail 

output of a Threshold object to both the Trigger and Enable inputs.  Then select 'End Note When Playing a New 

Note' in the Timing property page.  This will trigger the note as soon as the threshold condition is met, and the 

note will play as long as the threshold condition is met. 

See Also: 

MIDI Device Properties 

MIDI Notes Properties 

MIDI Volume Properties 

MIDI Timing Properties 

 

 

 

MIDI Device Properties 
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Device 

Selects the MIDI synthesizer device to be used by this object.  If this value is set to 'Default', the device 

specified in the Audio Preferences dialog will be used.  

Instrument 

Selects the MIDI instrument to use when playing notes.  

Scale 

Selects the musical scale.  

Key 

Selects the key in which the scale is played.  

Note 

Specifies the note to play when no connection is made to the Note input.  

Volume 

Specifies the note volume when no connection is made to the Volume input.  

Play Continuously 



When checked, this object will play a note even if no connections are made to its input ports.  

Channels 

Specifies the audio channel the object will use to play notes. 

MIDI Notes Properties 

  

Use this dialog to control how a signal connected to the object's Note input is mapped to a MIDI note.  

Signal 

Indicates the object and port that are connected to the object's Note input.  

Auto Range 

When enabled, the MIDI object will automatically adjust its Input Range based on the variations of the input 

signal.  

Period 

Sets the time period for the Auto Range calculation.  For example a setting of 30.0 means the Input Range will 

be set based on the variations of the input over the last 30 seconds.  

Input Range and Note Range 

mk:@MSITStore:C:/Program%20Files/BioExplorer/BioExplorer.chm::/Design_Objects/MIDI.htm


Specifies how input signals are mapped to MIDI notes.  

Mute if < and Mute if > 

These control what happens if the input value is outside the Input Range.  If checked, no note is played. 

 Otherwise, the note corresponding to the limit of the range is played.  

Only play on change 

Only plays a new note if it is different than the last note.  

Average Period 

The period of time over which the input signal is averaged.  This average value is then used to set the note 

value, using the Input Range and Note Range. 

MIDI Volume Properties 

  

Use this dialog to control how a signal connected to the object's Volume input is mapped to a volume level.  In 

the figure above an input of 0.0 would map to a volume of 30, and an input of 60.0u would map to full volume.  

Signal 

Indicates the object and port that are connected to the object's Volume input.  

Auto Range 
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When enabled, the player will automatically adjust its Input Range based on the variations of the input signal.  

Period 

Sets the time period for the Auto Range calculation.  For example a setting of 30.0 means the Input Range will 

be set based on the variations of the input over the last 30 seconds.  

Input Range and Volume Range 

Specifies how input signals are mapped to a volume range.  

Average Period 

The period of time over which the input signal is averaged.  This average value is then used to set the volume. 

Range is from 0.0 to 10.0 seconds. 

MIDI Timing Properties 

  

Use this dialog to specify when and how often MIDI notes are played.  

 

 

Signal 
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Indicates the object and port that are connected to the object's Trigger input.  If a connection is made to the 

Trigger input, the value specified in the Play Every field is ignored and a note is played whenever the Trigger 

input transitions from 0.0 to some other value.  

Play Every 

Specifies how often to play a note when there is no connection to the Trigger input.  

End Note When Playing a New Note 

When selected, each note will play until the next note is played.  Some instruments (pianos, drums, etc.) have a 

built in decay time.  In this case the note will decay at its own rate, regardless of this setting.  

End Note After 

Specifies how long each note should be played.  

Force Note on Enable 

When selected, a note will be played every time the Enable input transitions from zero to non-zero.  This can 

cause notes to be played more often than specified by the Play Every property if the Enable input is changing 

rapidly.  Set this if response time is more important than evenly timed notes in your application. 

Min 

The output will be the minimum value received over all input samples.  This object will be reset when the play 

state becomes stopped, or on a low to high (zero to non-zero) transition on the Reset input. 

NOT 

Calculates the logical NOT of its input signal.  If the input is 0.0, the output will be 1.0, otherwise the output 

will be 0.0. 

OR 

Calculates the logical OR of its input signals.  If any input signal is not 0.0, the output will be 1.0, otherwise the 

output will be 0.0. 

 

 

 



Oscilloscope 

This object is used to display one or more signals over time.  

  

The scale on the left side of the Oscilloscope indicates the scale of the current channel (in this case the third 

channel).  You can left-click the mouse on any channel to make it the current channel.  

The Oscilloscope will also display threshold information when connected to the Signal output of a Threshold 

object.  The Oscilloscope above indicates the threshold of its second channel with dotted horizontal lines. 

 

 

 

 

 

 

 

 



Oscilloscope Settings Properties 

  

Time/Div 

Sets the sweep rate of the Oscilloscope.  

Oversample 

Sets the amount of oversampling done internally by the Oscilloscope before plotting the signal.  This can reduce 

the effects of visual aliasing, giving a better representation of the signal.  

Show Header 

Turns on the Oscilloscope sensitivity header.  

Show Grid 

Draws a reference grid on the Oscilloscope screen.  

Show Labels 

Enables labeling of each channel with the object and output port that are being monitored.  
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Show Object Name 

Includes the name of the object that this channel is monitoring in the label.  

Thick Lines 

Increases the thickness of the oscilloscope traces.  

Grid Color 

Sets the grid color.  

Background Color 

Sets the background color. 

Oscilloscope Channel Properties 

  

Signal 

Indicates the object and port that are being displayed by this channel.  

Label 
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Sets the label for this input.  If this field is empty, the connected object name and port will be used as the label.  

Use Range 

By selecting this you can manually enter a display range for the channel.  In this case the sensitivity settings 

will be ignored.  

Auto Sensitivity 

When enabled will automatically adjust the sensitivity based on the signal.  

Auto Center 

When enabled will automatically center the signal in the display.  

Sensitivity 

Sets the sensitivity for this channel.  

Trace Color 

Sets the trace color for this channel.  

Percentile 

Calculates the specified percentile value of a signal over a specified period of time.  For example, if the 

percentile is set to 25% and the time period is set to 1 second, the output will be the input value that is greater 

than 25% and less than 75% of the input values over the previous second.  The output is recalculated every time 

an input sample is received.  

Setting the percentile to 50% will calculate the median. 

 

 

 

 

 

 



Percentile Properties 

  

Percentile 

Sets the desired percentile to calculate.  

Period 

Sets the period over which the percentile is calculated.    

Pulse Detector 

Given an EKG signal as an input, determines the current pulse rate.  

Outputs 

 Rate:  The current pulse rate in beats per minute. 

 Pulse:  A binary output.  Normally 0.0 but switches to 1.0 whenever a pulse is detected.  Example use 

would be to play a MIDI note when an EKG pulse occurs, by connecting this output to a MIDI Trigger 

input. 

Range Threshold 

Determines whether or not the input signal is within a target range.  The range can be set to a constant value or 

adjusted automatically based on the variability of the input signal.  In either case, this range is centered on the 

mean of the input signal.  The period over which this mean is calculated can be changed, allowing you to set 

how quickly the range tracks the input.  You can also specify an offset, which shifts the range up or down 

around the mean.  
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In the Range Threshold shown below, the blue bar indicates the value of the input signal and the yellow box 

indicates the current range.  The horizontal line near the middle of the range box indicates the current mean.  

  

There are two buttons at the bottom of the Range Threshold instrument:  

Auto/Manual:  Toggles between auto and manual threshold mode.  In auto mode the range is automatically 

adjusted based on the standard deviation of the previous epoch of data.  In manual mode the range is set to a 

fixed value.  

Reset/A->M:  The threshold object continuously calculates the range that corresponds to the specified number 

of standard deviations for all input values it has seen over the last epoch period of time.  In auto mode this 

button displays ‘Reset’.  Reset will clear the values accumulated over the previous epoch, allowing the range to 

quickly adjust to new values.  In manual mode this button will display ‘A->M’ (Auto to Manual).  Pressing this 

button will do a one-time setting of the range, using the last epoch of data and the specified number of standard 

deviations.  

Above the buttons are four indicator windows:  

The top window indicates the number of standard deviations used to calculate the range in auto mode, or when 

pressing the A->M button in manual mode.  Left clicking this window with the mouse will raise the value by 

0.1, right clicking will lower it by 0.1  



The middle window indicates the current range.  In manual mode, left clicking this window with the mouse will 

raise the value by 10%, right clicking will lower it by 10%.  In auto mode the window will be grayed out (as 

shown above), and will not respond to mouse clicks.  

The bottom left window indicates the offset in percent.  Left clicking this window with the mouse will increase 

the offset by 10%, right clicking will decrease it by 10%.  

The bottom right window indicates the percent success over the previous epoch.  

Inputs 

 In: The input signal. 

 Auto: This control input can be used to select auto or manual thresholds.  A zero input will put the 

threshold in manual mode, any other value will put it in auto mode.  

Outputs 

 Signal: The averaged input signal.  If the average period is set to 0 then this output will be a copy of the 

input signal.  Also carries threshold information which can be used by Display objects to indicate the 

current thresholds. 

 Pass/Fail: Indicates whether or not the input signal is within the current range.  1.0 indicates success, 0.0 

indicates failure. 

 Pass %: Indicates the total percent time that the threshold condition has been met.  This is reset every 

time the session is stopped, or whenever you perform a seek in playback mode. 

 Low: The lower value of the current range. 

 High: The upper value of the current range. 

 

 

 

 

 

 

 

 



Range Threshold Properties 

  

Input Average Period 

The period of time over which the input signal is averaged.  This averaging is not just used for display purposes, 

but is done before any other calculations are made.  Setting this value to 0 will disable input averaging.  

Targeting Average Period 

After any input averaging, the signal is again averaged to calculate the location of the threshold range.  The 

threshold range will be centered on this value, plus or minus the offset specified below.  This value is displayed 

in the instrument as the horizontal line inside the range box.  

Manual Range 

In manual mode the range is set to this value.  

Auto Range 

This value specifies the number of standard deviations used to calculate the range in auto mode.  

Epoch 
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The period of time over which the standard deviation is calculated.  

Offset Percent 

Use this setting to offset the range from the target mean. 

Range Threshold UI Settings 

  

Signal 

Indicates the object and port that are connected to the Threshold's input.  

Display Range 

The range displayed by the Threshold.  For example, if the range is 10u - 20u, 10u would correspond to the 

bottom of the display and 20u would correspond to the top of the display.  

Show Header 

Turns on the Threshold scale header.  

Show Label 
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Enables labeling the Threshold with the object and output port being monitored.  

Show Object Name 

Includes the name of the object being monitored in the label.  

Bar Pass Color 

Sets the bar color when the input is within the target range.  

Bar Fail Color 

Sets the bar color when the input is outside the target range.  

Box Color 

Sets the color of the box that indicates the target range.  

Background Color 

Sets the background color.  

Box Fill 

Sets the style of the box fill pattern. 

Sample & Hold 

When the Hold input is zero, the output follows the input.  Otherwise the output will hold at whatever value the 

input was at when the Hold input changed from zero to non-zero. 

 

 

 

 

 

 



Sample & Hold Properties 

  

Dwell Period 

Set this property to have the object hold its output for a specified period after the Hold input returns to zero. 
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Score Settings 

  

Server 

Use this object to stream data from BioExplorer's Signal Diagram in real-time.  The BioExplorer Client 

Interface can be used to develop applications that can receive and use this data.  

Source Object 

This object represents a channel on a Data Acquisition Device (e.g. BrainMaster channel 1, etc).  Source objects 

are used to get data from a device into the Signal Diagram window.  

Channel Mapping 

BioExplorer will attempt to map Source channels when opening a design or when switching from playback to 

capture mode.  It uses the signal type property of the Source object to do this.  For example, suppose you open a 

design created by someone who owns an Abhayamudra II, but you own a BrainMaster.  BioExplorer will first 

look for any Abhayamudra II channels on your system, and not finding any it will then look for channels that 
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support the specified signal type.  If you own hardware that has channels that support the EEG signal type, it 

will substitute those channels for the ones originally specified in the design.  This allows users of different 

hardware to share designs, as long their hardware can support the signal types used in the design. 

Source Properties 

  

Channel 

The hardware channel this Source object represents.  In Capture mode you can specify any unused channel on 

the installed hardware devices.  In Playback mode BioExplorer is playing back a previously recorded session, 

and the list of channels will be limited to those that were recorded in the session.  

Signal Type 

Sets the signal type of the Source object.  
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Spectrum Analyzer 

This object is used to display the spectrum of a signal.  The spectrum can be viewed in several different 

formats.  

  

This Spectrum Analyzer is displaying a user's eyes-closed EEG in 3D format.  The alpha rhythm is clearly 

visible as the peak at 10Hz. 

 

 

 

 

 

 

 

 

 



Spectrum Analyzer Properties 

  

Signal 

Indicates the object and port that are connected to the Spectrum Analyzer's input.  

Refresh Period 

The period at which the display is updated, or redrawn.  Range is from 10.0mS to 10.0 seconds.  The spectrum 

is calculated each time the display is updated, using the last 'FFT Period' amount of data received by the 

Spectrum Analyzer.  

FFT Period 

Indicates the period of data required to perform a single FFT at the current sample rate and Bin count.  
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Show Headers 

Turns on the scale header.  

Show Labels 

Enables labeling the spectrum with the object and output port that are being monitored.  

Show Object Name 

Includes the name of the object that this channel is monitoring in the label.  

Min Frequency 

Sets the minimum frequency of the spectrum display.  

Max Frequency 

Sets the maximum frequency of the spectrum display.  

Bins 

Sets the number of bins used by the FFT in calculating the spectrum.  Higher numbers give better frequency 

resolution but lower time resolution.  

Sensitivity 

Sets the display sensitivity.  

Amplitude 

Sets the display scale to Amplitude  

Percent Amplitude 

Sets the display scale to percent amplitude.  In this mode each bin indicates the percentage of total signal 

amplitude at that frequency.  

Percent Power 

Sets the display scale to percent power.  In this mode each bin indicates the percentage of total signal power at 

that frequency.  

Data Window Type 

Sets the type of window used on the data before the FFT is calculated.  



Data Window Alpha 

This parameter is used by the Blackman and Kaiser window types.  

Display Type 

Sets the display type.  

Display Orientation 

Sets the display orientation.  

Color Scheme 

Sets the colors used by the display.  

Background Color 

Sets the background color.  

Standard Deviation 

Calculates the Standard Deviation and Mean of a signal over a specified time period. 

Standard Deviation Properties 

  

Period 

Sets the time period over which the Standard Deviation is calculated. 
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Tactile Feedback 

Threshold 

Compares an input signal to a threshold value or values.  You can set the thresholds manually or have the object 

adjust them automatically based on characteristics of the signal.  

  

There are four buttons at the bottom of the Threshold instrument:  

Auto/Manual:  Toggles between auto and manual threshold mode.  In auto mode the object automatically 

adjusts the threshold(s) based on the previous epoch of data.  In manual mode the thresholds can be set by 

dragging the horizontal threshold indicators with the mouse.  

Single/Double:  Single has one threshold, double has two thresholds.  

Increase/Decrease:  Toggles the goal.  If set to Increase then the threshold condition is met whenever the input 

signal is greater than the threshold.  Only enabled in Single threshold mode.  

Reset/A->M:  The threshold object continuously calculates the percentage success rate for all input values it has 

seen over the last ‘epoch’ period of time.  In auto mode this button will display ‘Reset’.  Reset will clear the 

values accumulated over the previous epoch, allowing the threshold to quickly adjust to new values.  In manual 

mode this button will display ‘A->M’ (Auto to Manual).  Pressing this button will do a one-time setting of the 

thresholds, based on the current percentage success targets.  



Above the buttons are three small indicator windows.  In auto mode these windows display the current percent 

success targets.  The left window displays ‘>75’.  This indicates that the first threshold will adjust so that the 

input signal is greater than it 75 percent of the time.  The middle window indicates that the second threshold 

will adjust so the input signal is less than it 75 percent of the time.  The right window indicates the overall 

percent success, 50 percent in this case.  You can adjust these targets by clicking on them with the mouse.  A 

left click will raise the target by 1 percent, and a right click will lower it by 1 percent.  You can only adjust the 

individual targets, not the overall percent success.  The overall percent success will update automatically when 

you adjust either of the threshold targets.  

In manual mode these indicators will display the current success rate for the thresholds over the last epoch.  

Ratio Output 

The primary purpose of the Ratio output is to normalize or map an arbitrary input signal range to a 0.0 - 1.0 

output range.  This allows applications that are driven by data from BioExplorer (e.g. Flash games, applications 

connected to the Server object, etc) to expect values between 0.0 and 1.0, and not be concerned with the actual 

signal range of the underlying data.    

Inputs 

 In: The input signal. 

 Auto: This control input can be used to select auto or manual thresholds.  A zero input will put the 

threshold in manual mode, any other value will put it in auto mode.  

Outputs 

 Signal: The averaged input signal.  If the average period is set to 0 then this output will be a copy of the 

input signal.  Also carries threshold information which can be used by Display objects to indicate the 

current thresholds. 

 Pass/Fail: Indicates if the input signal passes the threshold criteria.  1.0 indicates success, 0.0 indicates 

failure. 

 Pass %: Indicates the total percent time that the threshold condition has been met.  This is reset every 

time the session is stopped, or whenever you perform a seek in playback mode. 

 Low: The current value of Threshold 1. 

 High: The current value of Threshold 2.  If the Threshold object is configured as a single threshold this 

value will be 0.0 

 Ratio: The ratio of the current value to the threshold(s).  In single threshold mode, the value is Input 

Value / Threshold Value.  In double threshold mode, the value is ( Input Value - Low Threshold Value ) 

/ ( High Threshold Value - Low Threshold Value ).  This output can also take into account the 

Increase/Decrease (reward/inhibit) mode of the threshold.  In this case the Ratio output is reversed - i.e. 

the Ratio will go up as the input signal goes down. 

 

 



Threshold Properties 

  

Manual Targets 

Specifies the threshold values in manual mode.  

Auto Targets 

Specifies the target percent success for each threshold in auto mode.  For example a value of 75 means that the 

threshold value will be adjusted so that the condition is met 75 percent of the time.  

Auto 

When enabled, the object will automatically adjust the threshold values in an attempt to achieve the percent 

success targets.  

Single 

When selected the object uses one threshold, and pass/fail depends on the input signal being higher or lower 

than this threshold.  If not selected the object uses both thresholds, and pass/fail is based on whether or not the 

input signal is between the thresholds.  

Increase 

If selected in Single threshold mode, the threshold condition is met when the input signal is greater than the 

threshold value.  Otherwise the threshold condition is met when the input signal is lower than the threshold 

value.  
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Reverse Ratio Output if Increase is not set 

If this is set and Increase is not set (i.e. the goal is to reduce or inhibit the input signal), the Ratio output will 

increase as the input signal decreases.   

Epoch 

The period of time over which the object calculates statistics of the input signal.  These statistics are used to 

determine the thresholds in Auto mode, and to display the percent success for a given threshold value in manual 

mode.  

Duration 

The period of time that the threshold condition must be met before the object indicates pass, or success.  For 

example, a single threshold with a goal of increase and a duration of 1.0 will not output a Pass signal until the 

input is greater than the threshold value for at least one second.  

Threshold Settings 

  

Signal 

Indicates the object and port that are connected to the Threshold's input.  

Display Range 

The range displayed by the Threshold.  For example, if the range is 10u - 20u, 10u would correspond to the 

bottom of the display and 20u would correspond to the top of the display.  
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Average Period 

The period of time over which the input signal is averaged.  This averaging is not just used for display purposes, 

but is done before any other calculations are made.  Threshold comparisons and statistical analysis are 

performed on the signal after it is averaged.   

Show Header 

Turns on the Threshold scale header.  

Show Label 

Enables labeling the Threshold with the object and output port being monitored.  

Show Object Name 

Includes the name of the object being monitored in the label.  

Bar Pass Color 

Sets the bar color when the input is within the target range.  

Bar Fail Color 

Sets the bar color when the input is outside the target range.  

Background Color 

Sets the background color. 

Tone Generator 

Generates an audio tone.  Frequency, Volume, and Enable can be controlled from the Signal Diagram. 

 

 

 

 

 



Tone Generator Settings 

  

Frequency 

Specifies the frequency of the tone when no connection is made to the Frequency input.  

Volume 

Specifies the volume of the tone when no connection is made to the Volume input.  

Play Continuously 

When checked, this object will play a tone even if no connections are made to its input ports.  

Channels 

Specifies the audio channel(s) on which the tone will play. 
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Tone Generator Frequency Properties 

  

Use this dialog to control how a signal connected to the object's Frequency input is mapped to a frequency.  

Signal 

Indicates the object and port that are connected to the object's Frequency input.  

Auto Range 

When enabled, the MIDI object will automatically adjust its Input Range based on the variations of the input 

signal.  

Period 

Sets the time period for the Auto Range calculation.  For example a setting of 30.0 means the Input Range will 

be set based on the variations of the input over the last 30 seconds.  

Input Range and Frequency Range 

Specifies how input signals are mapped to frequency.  

Average Period 

The period of time over which the input signal is averaged.  This average value is then used to set the 

frequency, using the Input Range and Frequency Range. 
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Tone Generator Volume Properties 

  

Use this dialog to control how a signal connected to the object's Volume input is mapped to a volume level.  In 

the figure above an input of 0.0 would map to a volume of 0, and an input of 60.0u would map to full volume.  

Signal 

Indicates the object and port that are connected to the object's Volume input.  

Auto Range 

When enabled, the player will automatically adjust its Input Range based on the variations of the input signal.  

Period 

Sets the time period for the Auto Range calculation.  For example a setting of 30.0 means the Input Range will 

be set based on the variations of the input over the last 30 seconds.  

Input Range and Volume Range 

Specifies how input signals are mapped to a volume range.  

Average Period 

The period of time over which the input signal is averaged.  This average value is then used to set the volume. 

 Range is from 0.0 to 10.0 seconds. 
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Trend 

The Trend object displays the mean value of one or more signals over time. 

  

Trend Settings 

  

Display Range 

Sets the visible display range.  
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Auto Range 

Sets the Display Range automatically based on the input signals.  

Average Period 

The period of time over which the input signal is averaged before being displayed, in seconds.  

Time Span 

Sets the time span of the display.  For example setting this to 10:00 means that the last 10 minutes of data will 

be displayed.  

Horizontal Division 

Sets the horizontal division period, in seconds.  

Show Header 

Turns on the Trend scale header.  

Show Grid 

Draws a reference grid on the Trend display.  

Show Label 

Enables labeling of each channel with the object and output port that are being monitored.  

Show Object Name 

Includes the name of the object that this channel is monitoring in the label.  

Grid On Top 

Draws the reference grid above the trend line(s).  

Thick Lines 

Increases the thickness of trend graph lines.  

Grid Color 

Sets the grid color.  

Background Color 



Sets the background color. 

Trend Channel Properties 

  

Signal 

Indicates the object and port that are being displayed by this channel.  

Label 

Sets the label for this input.  If this field is empty, the connected object name and port will be used as the label.  

Line 

Channel data will be rendered as a line.  This is useful when displaying more than one channel, as the Solid and 

Color Scheme styles are opaque and may hide data from other channels.  

Solid 

Channel data will be rendered as a filled solid color.  

Color Scheme 

Channel data will be rendered as a filled color gradient.  
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Video Player 

Plays video files - mpeg, wmv, avi, etc.  Volume, Position, and Enable can be controlled from the Signal 

Diagram. 

  

  

Video Player Playlist 
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Use this dialog to create a playlist for the Video Player.  

The red X next to the fourth item above indicates that the file cannot be found.  This can happen when moving a 

design to a new computer.  If this is the case either copy the missing file to the specified location, or delete the 

entry and add a new file.  

Add 

Opens a file selection dialog you can use to choose video files.  

Remove 

Removes all selected files from the playlist.  

Move Up 

Moves the selected file up in the play order.  

Move Down 

Moves the selected file down in the play order. 

Video Player Settings 
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Volume 

Specifies the player volume when no connection is made to the object's Volume input.  

Brightness 

Sets the player video brightness when no connection is made to the Brightness input.  

Size 

Sets the player video size when no connection is made to the Size input.  

Background Color 

Sets the background color of the video display area.  

Repeat 

If selected, the player will replay the playlist when it finishes. 

Video Player Volume Properties 

  

Use this dialog to control how a signal connected to the player's Volume input is mapped to a volume level.  In 

the figure above an input of 0.0 would map to zero volume, and an input of 60.0u would map to full volume.  
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Signal 

Indicates the object and port that are connected to the player's Volume input.  

Auto Range 

When enabled, the player will automatically adjust its Input Range based on the variations of the input signal.  

Period 

Sets the time period for the Auto Range calculation.  For example a setting of 30.0 means the Input Range will 

be set based on the variations of the input over the last 30 seconds.  

Input Range and Volume Range 

Specifies how input signals are mapped to a volume range.  

Average Period 

The period of time over which the input signal is averaged.  This average value is then used to set the volume. 

Range is from 0.0 to 10.0 seconds. 

Video Player Position Properties 
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Use this dialog to specify how a signal connected to the player's Position input control the positioning of the 

video.  

Signal 

Indicates the object and port that are connected to the player's Position input.  

Auto Range 

When enabled, the Media Player will automatically adjust its Input Range based on the variations of the input 

signal.  

Period 

Sets the time period for the Auto Range calculation.  For example a setting of 30.0 means the Input Range will 

be set based on the variations of the input over the last 30 seconds.  

Input Range 

These values control how input signals are mapped to media position in proportional positioning mode.  For 

example, if the Range is 0.0u through 50.0u, an input of 0.0u is mapped to the beginning of the media and an 

input of 50.0u is mapped to the end of the media.  An input of 25.0u would seek to the middle of the media.  

Average Period 

The period of time over which the input signal is averaged.  This average value is then used to set the position. 

 Range is from 0.0 to 10.0 seconds.  

Proportional Positioning 

When selected, the input signal is compared with the position mapping values to determine the absolute position 

within the media.  

Frame Number Positioning 

Interprets the integer portion of the input as a frame number (e.g. 10.23 = frame 10, etc.)  This mode is typically 

used when the position input is driven by a Counter object. 

WM DVD Player 

Plays DVD video.  Volume, Enable, Size, and Brightness level can be controlled from the Signal Diagram.  
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Menu Button 

Displays the DVD menu.  The DVD Player supports on-screen navigation of the displayed menu using the 

mouse.  

Control Button 

When this button is pressed, signals from the player's Volume, Enable, Brightness, and Size inputs are used to 

control DVD playback.  Otherwise these input signals are ignored.  Turning off input control is useful when 

navigating the DVD with the on-screen menu.  Pressing the Menu button will automatically turn off input 

control.  

Config Button 

Displays the Windows Media Player context menu.  Use this to set player options, etc.  

Full Button 

When a DVD is playing, switches the player to full-screen mode.  You can exit full screen mode by pressing the 

Escape key or by right-clicking the video and selecting Exit Full Screen.  

Unlike the other player objects in BioExplorer, the DVD Player has independent Play/Pause/Stop control from 

its user interface.  This is due to the relatively long time it takes to set up a DVD (navigating the menu, selecting 

a chapter, etc.).  For example, you might want to record more than one session while running a DVD. 

 Independent play control allows you to stop the session without restarting the DVD.  



DVD Playback is demanding in terms of CPU resources and may adversely impact the response time of 

BioExplorer, depending on the system.  Factors that effect response time are CPU speed, video card 

acceleration of DVD decoding, and system memory.  Newer machines that have a CPU speed of at least 1GHz, 

128MB of memory, and a relatively fast video card should work well.  Windows should be configured to use 

the maximum hardware acceleration of the video card.  

Requirements 

 Windows XP or later. 

 Microsoft's Windows Media Player 10.  You can get it here. 

 A DVD/MPEG2 decoder compatible with Windows Media Player. 

 DVD compatible disk drive.  

Setup  

1. Verify that Windows Media Player can play DVDs  

As the WM DVD Player object uses Windows Media Player internally, it will not work unless Windows Media 

Player can successfully play DVDs.  

 Insert a DVD in the drive 

 Run Windows Media Player 

 From the Play menu under the "DVD, VCD or CD Audio option", select the drive containing a DVD.  

At this point Windows Media Player should start playing the DVD.  

If you don't have a compatible DVD decoder installed, Windows Media Player will display the following 

message:  

  

Press the Web Help button and select the "DVD Decoder Plug-ins" link to purchase a DVD decoder.  We do not 

recommend using the Sonic CinePlayer decoder - the playback quality is better with the other options.  

You can also get a Windows Media Player compatible decoder by installing the full version of WinDVD, 

PowerDVD, or other DVD playback software.  

Microsoft has a useful utility that displays the DVD decoders installed on your system, the Windows XP Video 

Decoder Checkup Utility  

2. Close Windows Media Player and run BioExplorer.  

http://www.microsoft.com/windows/windowsmedia/mp10/default.aspx
http://www.microsoft.com/downloads/details.aspx?FamilyId=DE1491AC-0AB6-4990-943D-627E6ADE9FCB&displaylang=en
http://www.microsoft.com/downloads/details.aspx?FamilyId=DE1491AC-0AB6-4990-943D-627E6ADE9FCB&displaylang=en


3. Test the WM DVD Player object by opening the WMDVD.bxd design in the Examples folder.  

 Select Open from the Design menu 

 Browse to the Examples folder 

 Select WMDVD.bxd and press the Open button  

4. Configure the WM DVD Player to use the Video Mixing Renderer (VMR)  

The VMR is required to use Size, Brightness, and Enable control.  It is also required to play video on a second 

monitor on most systems.  

 Press the Config button on the WM DVD Player control bar 

 Select Options... 

 Select the Performance tab 

 Press the Advanced button 

 In the DVD Video section, check Use video mixing renderer, uncheck Use overlays, and uncheck 

Optimize performance for batteries if available 

 Set the Preferred decoder to Hardware, if available 

 Press OK in this dialog and the Options dialog to return to BioExplorer   

   



5. Press the Play or Menu button on the WM DVD Player control bar.  The DVD should start playing, and 

"VMR on" should be displayed in the status window as show below:  

  

If "VMR on" is not displayed you will only be able to control the player volume from the BioExplorer Signal 

Diagram.  Make sure you have configured the player as described in step 4 above.  If "VMR on" is still not 

displayed, your video card may not be capable of this functionality.  

Assuming everything is working, you can now use the WM DVD Player object in your designs.  You should 

not have to repeat the Setup steps above unless you change your computer's configuration (e.g. install a 

different DVD decoder, etc).  

Enable Input 

Enable control on this player works differently than with the original DVD Player object.  In this player enable 

will toggle the video on and off, but the DVD soundtrack will continue to play  

WM DVD Player Settings 

  

Volume 

Set the player volume when no connection is made to the Volume input.  

Brightness 

Sets the player video brightness when no connection is made to the Brightness input.  
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Size 

Sets the player video size when no connection is made to the Size input.  

Background Color 

Sets the background color of the video display area.  

DVD Drive 

Specifies which DVD drive is used by the player. 

WM DVD Player Volume Properties 

  

Use this dialog to control how a signal connected to the player's Volume input is mapped to a volume level.  In 

the figure above an input of 0.0 would map to a volume of 0, and an input of 50.0u would map to full volume.  

Signal 

Indicates the object and port that are connected to the player's Volume input.  

Auto Range 

When enabled, the player will automatically adjust its Input Range based on the variations of the input signal.  

Period 

Sets the time period for the Auto Range calculation.  For example a setting of 30.0 means the Input Range will 

be set based on the variations of the input over the last 30 seconds.  
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Input Range and Volume Range 

Specifies how input signals are mapped to a volume range.  

Average Period 

The period of time over which the input signal is averaged.  This average value is then used to set the volume. 

Range is from 0.0 to 10.0 seconds. 

 WM DVD Player Brightness Properties 

  

Use this dialog to specify how a signal connected to the player's Brightness input controls the video brightness.  

Signal 

Indicates the object and port that are connected to the player's Position input.  

Auto Range 

When enabled, the player will automatically adjust its Input Range based on the variations of the input signal.  

Period 

Sets the time period for the Auto Range calculation.  For example a setting of 30.0 means the Input Range will 

be set based on the variations of the input over the last 30 seconds.  

Input Range and Brightness Range 
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Specifies how input signals are mapped to a brightness level.  An input value between the minimum and 

maximum Input Range will be linearly mapped to a brightness level.  The maximum brightness level is 1.0  

Average Period 

The period of time over which the input signal is averaged.  This average value is then used to set the 

brightness.  Range is from 0.0 to 10.0 seconds. 

 WM DVD Player Size Properties 

  

Use this dialog to specify how a signal connected to the player's Size input controls the video size.  

Signal 

Indicates the object and port that are connected to the player's Size input.  

Auto Range 

When enabled, the player will automatically adjust its Input Range based on the variations of the input signal.  

Period 

Sets the time period for the Auto Range calculation.  For example a setting of 30.0 means the Input Range will 

be set based on the variations of the input over the last 30 seconds.  

Input Range and Size Range 
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Specifies how input signals are mapped to a size.  An input value between the minimum and maximum Input 

Range will be linearly mapped to a size.  The maximum size is 1.0  

Average Period 

The period of time over which the input signal is averaged.  This average value is then used to set the size. 

Range is from 0.0 to 10.0 seconds.  

X-Y Oscilloscope Settings 

  

Sensitivity 

Sets the display sensitivity for the input channels.  

Y Same As X 

When selected, the Y channel sensitivity will be set to the same value as the X channel.  

Persistence 
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Sets how long (in seconds) input data remains on the screen.  Higher values will give longer traces.  

Show Headers 

Displays the Oscilloscope sensitivity headers.  

Show Labels 

Enables labeling of each channel with the object and output port that are being monitored.  

Show Object Name 

Includes the name of the object that this channel is monitoring in the label.  

Interpolate 

Interpolates between sample values to produce a smoother display.  

Thick Lines 

Increases the thickness of the oscilloscope trace.  

Trace Color 

Sets the trace color.  

Background Color 

Sets the background color.  

 

 

 

 

 

 

 



X-Y Oscilloscope 

  

In this display, horizontal deflection is controlled by the X input and vertical deflection is controlled by the Y 

input.  This can be useful to determine phase and frequency relationships between both input signals. 



BioExplorer Client Interface  

Overview 

The BioExplorer Client Interface can be used to develop applications that receive streaming data from 

BioExplorer in real-time.  

The underlying data transport mechanism is TCP/IP.  This allows you to receive data across a local area 

network (LAN), or even the Internet.  

The following assumes the reader has experience with COM and ActiveX programming.  

Using the COM Interface from C++  

The file BEClientInterface.h, located in the BioExplorer\Code\include folder, contains the relevant interface 

declarations.  

1. Implement the callback interface IBEClientMonitor.  Methods of this interface will be called by the BEClient 

object to notify your application of state changes, arrival of data, etc.  

2. Create a BEClient object.  This is typically done as follows:  

HRESULT hr; 

IBEClient *pClient;  

hr = CoCreateInstance( 

          CLSID_CBEClient, 

          NULL, 

          CLSCTX_INPROC_SERVER, 

          IID_IBEClient, 

          (void **)&pClient );  

The BEClient object handles the low-level details of communicating with a Server object in the BioExplorer 

Signal Diagram.  

3. Initialize the BEClient object.  

hr = pClient->Initialize();  

4. Register your callback interface with BEClient to receive event notifications.  Assuming that you are making 

this call from within an object that implements IBEClientMonitor:  

hr = pClient->Monitor( (IBEClientMonitor *)this, dwUser );  

At this point the IBEClientMonitor methods implemented in your object may be called at any time by the 

BEClient object.  
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5. Connect to a Server object running in BioExplorer.  To connect to a Server running on the same machine as 

your application:  

hr = pClient>Connect( "127.0.0.1" );  

When the connection succeeds (or fails), your object will be notified with the IBEClientMonitor::OnConnect 

function.  

Once your object has connected it will receive event notifications in response to state changes in BioExplorer.  

6.  If you wish to connect to a different Server or shutdown the BEClient object, first disconnect from the 

current Server object.  

hr = pClient->Disconnect();  

7. When you're finished using the BEClient object, unregister your callback interface, and shutdown and release 

the object.  

hr = pClient->UnMonitor( (IBEClientMonitor *)this ); 

hr = pClient->Shutdown(); 

pClient->Release();  

It's important to call UnMonitor BEFORE the IBEClientInterface pointer passed to the original Monitor call 

becomes invalid.  

Using the ActiveX control object  

Installing BioExplorer version 1.2 or later registers the "BioExplorerClient" Control in Windows.  This control 

can be used with Visual C++, Visual Basic, etc. by adding it to your project.  

For example, in Visual C++ 6.0:  

1. From the Project -> Add To Project menu, select Components and Controls.  

2. From the Components and Controls Gallery, double-click Registered ActiveX Controls.  

3. Select the BioExplorerClient Control from the list.  

4. Press the Insert button.  

5. Press OK when asked if you want to "Insert this component".  

6. A C++ wrapper class will be generated and added to your project.  

Sample programs  
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Sample programs can be found in the BioExplorer\Code folder.  Release mode executable binaries are included 

in the Release folder (e.g. C:\Program Files\BioExplorer\Code\BETestClient\Release\BETestClient.exe).  

BETestClient: Visual C++/MFC program using the COM interface.  

BEOCSTestClient: Visual C++/MFC program using the ActiveX control.  

Both sample programs use the same user interface:  

  

Discovered servers are listed in the combo control at the lower left corner of the window.  If the Auto Connect 

button is checked, the client will connect to the first server it discovers.  You can also enter a dotted-IP address 

in this field and press the Connect button.  



The sample program draws a bar graph for each channel connected to the Server object in the Signal Diagram. 

 The range of each bar graph is hard-coded to 0 - 60u, which works well for displaying EEG filter amplitudes.  

To test either of these programs:  

1. Run BioExplorer.  

2. Open the Server.bxd design located in the Examples folder.  

3. Open the session CESample1.bxs located in the Examples folder.  When asked if you want to "Open the 

Session's Design", click no.  

4. Run one of the sample programs.  It must be running on a machine that is networked to the machine running 

BioExplorer, or the same machine.  

5. The sample program should find the Server object running in BioExplorer.  Select it in the combo control and 

press the Connect button.  

Once connected, you can play the session in BioExplorer and view the filter amplitudes in the sample program. 

Client Events 

OnServerAdded 

Called when a new server is discovered by the BEClient object.  The scope of the server discovery feature is 

limited to the local area network on which the Server object is running.  

OnServerRemoved 

Called when the indicated server is no longer visible to the BEClient object.  

OnConnect 

Notification that connection to a server object is complete (hr = NOERROR), or has failed (hr contains the error 

code).  This notification is in response to an IBEClient::Connect call.  

OnDisconnect 

Notification that the BEClient object has disconnected from the server.  Can be initiated by calling 

IBEClient::Disconnect.  Can also be initiated from BioExplorer by removing the Server object from a design, 

closing the design, or closing BioExplorer.  

OnChannelAdded 

Called when a new connection is made to the Server object in BioExplorer's Signal Diagram (i.e. an object's 

output port is connected to the Server object's input port).  



OnChannelRemoved 

Called when a connection to the Server object's input port is removed in BioExplorer's Signal Diagram.  

OnChannelNameChanged 

Called when the name of a connected channel changes.  Channel names can be set in BioExplorer using the 

Server object's properties dialog.  

OnChannelSampleRateChanged 

Called when the sample rate of a connected channel changes.  

OnChannelSamples 

Called when the BEClient object receives data samples from the Server object.  

OnPlay 

Notification that BioExplorer has switched to the Play state.  

OnPause 

Notification that BioExplorer has switched to the Pause state.  

OnStop 

Notification that BioExplorer has switched to the Stopped state. 



Tutorials 

Installing a Device 

Playing a Previously Recorded Session 

Creating a Design 

Creating and Running a Report in BioReview 

Installing a Device 

1.  Choose 'Devices' from the BioExplorer menu.  This will display the Device Manager dialog.  The Device 

Manager allows you to add and remove devices and set device properties.  

  

2.  Press the 'Add' button on the Device Manager dialog, displaying the New Device dialog.  

  

3.  Choose the type of Device you would like to install, and press OK.  

4.  At this point the Device Properties dialog will be displayed.  This is where you specify how the Device is 

connected to your computer.  Additional configuration may be required depending on the type of Device 

you are installing.  See the Supported Devices section for more information.  
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5.  After configuring the device, press OK on the Device Properties dialog.  

6.  You should see your device listed in the Device Manager.  If you need to change the Device's configuration, 

select it and press the Properties button.  When finished press the Close button, and you will be returned to 

the program.  

  

7.  You can use the Status Bar to see if BioExplorer is successfully communicating with the Device.  Connect 

the Device to the port you specified in step 4 and make sure the device is on.  The Status Bar should 

indicate the Device's state as CONNECTED.  If you have more than one Device installed, left click the 

mouse on the Device name in the Status Bar to scroll through all Devices.  
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Playing a Previously Recorded Session 

1.  Choose 'Playback' from the Session menu.  This will display the Playback Session dialog.  

  

2.  Select the Session you would like to open and press the Open button.  

3.  At this point you will be asked if you want to open the Session's Design.  Every time you record a Session 

BioExplorer saves the current Design in the Session file as well.  If you press 'Yes' BioExplorer will open 

that Design.  

  

4.  The Session file is now open for Playback.  You can use the Control Bar to play and seek though the 

Session.  You can modify the Signal Diagram to process the Session data in different ways.  

5.  To return to Capture mode, choose 'Capture' from the File menu. 

Creating a Design 

1.  Chose New from the Design menu.  

2.  Now we will add the Design Objects to implement our Design.  Choose Add Object from the Design menu. 

 This will display the Objects dialog.   
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3.  Add a Source object by selecting it in the Objects dialog and pressing the Add button, or by double clicking 

the entry in the list.  This object will supply the data for our Design.  

4.  In the same manner, add a Bandpass Filter, Oscilloscope, Spectrum Analyzer, and MIDI object.  When 

you're done press the Close button to return to the program.  

5.  You should see the objects you've added in the Signal Diagram window.  If you want to remove an object 

you can select it by left clicking it with the mouse, and then press the delete key.  You can also right click it 

with the mouse and choose Delete from the context menu.  You can move the objects by left clicking and 

dragging them with the mouse.  Arrange them so your Signal Diagram looks something like this:  

  

6.  Now we're going to add our connections.  Connections specify how data flows through the Signal Diagram. 

 You connect objects by left clicking on an object's port (the blue and green circles), and then dragging the 

connection to another object's port.  If you make a mistake or need to remove a connection, select it by left 

clicking it with the mouse and then press the delete key.  You can also right click it with the mouse and 

then choose Delete from the context menu.  Add connections so your Signal Diagram looks like this:  



  

7.  The object labeled 'Source 1' is our Source object.  This object brings data from a hardware channel into the 

Signal Diagram.  To specify which channel to use, right click the object and then choose Properties from 

the context menu.  You can also double click the object to bring up its property page.  

8.  Now choose a channel from the list of channels in the Source object's property page.  If the list of Channels 

is empty, you need to install a device.  You should choose a channel on a device capable of capturing EEG 

signals.  After setting the channel, make sure the Signal Type is set to EEG.  When you are finished press 

the OK button to return to the program.  

  

9.  The Source object in your Signal Diagram should now indicate the channel you specified.  
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10.  Now we will configure the MIDI object.  As you can see from the Signal Diagram, we have the Amplitude 

output of the Bandpass Filter controlling the MIDI Note.  We need to specify what range of Amplitude 

values gets mapped to a range of notes.  Open the MIDI object's property page by double clicking the 

object, and then select the Notes tab.  

  

11.  Currently the MIDI object is configured to map an Input Range of 0 - 60u to a Note Range of 30 - 90.  We 

want to change the Input Range to 0 - 80u so the MIDI notes can respond to a greater range of input 

signals.  Change the second (rightmost) Input Range value from 60u to 80u.  When you are finished press 

OK to return to the program.  

12.  Now we need to arrange our Instruments.  The Oscilloscope and Spectrum Analyzer objects have user 

interfaces, or Instruments.  When we added them to the Signal Diagram their Instruments were added to the 



Instruments window.  Bring the Instruments window to the foreground by left clicking it with the mouse, 

or choosing 'Instruments 1' from the Window menu.  You should see something like this:  

  

13.  The Instruments window is currently in 'Edit' mode.  In Edit mode you can move and resize the 

Instruments.  When you have the Instruments arranged how you want, choose Edit Layout from the 

Instruments menu to toggle off Edit mode.  Now the Instruments are locked in place and will resize with 

the Instruments window.  

  



14. At this point you should save your Design.  Choose 'Save Design As' from the File menu.  Enter a name for 

your design in the Save Design dialog and press the Save button.  

15. To 'play' your design, first make sure the device specified in the Source object is connected.  Then press the 

play button, or choose Play from the Session menu.  You should see data from your device in the 

Oscilloscope and Spectrum Analyzer, and hear the MIDI notes played by your sound card. 

Creating and Running a Report in BioReview 

1.  Open BioReview.  

2.  Choose New from the Report menu to create a new report.  

3.  In the dialog that opens choose the sample session CESample1.bxs and press the Open button.  BioReview 

uses the Session file to determine the number and type (EEG, GSR, EKG, etc.) of channels to be used in this 

report.  In this case two EEG channels are added to the Signal Diagram.  These are the two channels of EEG 

data that are recorded in the CESample1 session file.  

4.  The next step is to modify the Signal Diagram to generate some signals of interest.  Suppose we want to 

calculate and display the mean alpha amplitude and frequency for each channel.  To do this we'll need two 

Bandpass Filter objects and two Mean Frequency objects.  Add these to the Signal Diagram by choosing Add 

Object from the Signal Diagram menu.  

5.  Connect the output of Source 1 to the input of Bandpass Filter 1 and Mean Frequency 1.  

6.  Connect the output of Source 2 to the input of Bandpass Filter 2 and Mean Frequency 2.  The Signal 

Diagram should look something like this:  

  

7.  Using the mouse, double click Mean Frequency 1 to display its property page.  Change the frequency range 

to 8.0 - 12.0 and press OK.  Do the same for Mean Frequency 2.  



8.  The Signal Diagram is now configured to calculate our signals of interest.  To view these signals, add a View 

window to the report by choosing New from the View menu.  A View window can be used to display the 

statistics of any output port in the Signal Diagram in a variety of formats.  

9.  Click on the View window with the mouse to make sure it is selected.  Then choose 'Add Signal...' from the 

View menu.  This opens the Signals dialog, which lists all output ports in the Signal Diagram.  

10.  Add the Amplitude output of Bandpass Filter 1 to the View by selecting it in the Signals dialog and then 

pressing the Add button.  

11.  In the same way, add the Amplitude output of Bandpass Filter 2 and the Freq output of both Mean 

Frequency objects.  Your View window should look like this:  

  

12.  Now is a good time to save your report.  Choose Save As from the Report menu, enter a name, and press 

the Save button.  

13.  You can now run your report on the current session (CESample1.bxs) by choosing Run from the Report 

menu.  After doing this each View window will report the statistics for its signals, as shown below.  

The lower portion of the View displays each signal in this view, and the summary statistics for those signals. 

 Summary statistics are calculated across the entire current time span, which defaults to the length of the 

session.  The mean value for the first signal in the list below is 22.5u.  This indicates that the mean value of 

channel 1's 8-12Hz amplitude for the entire session is 22.5 microvolts.  

The upper portion of the View displays the mean value of each epoch of the session on a chart.  You can also 

view these mean values in a table, by selecting the Table tab in the upper left corner of the View.  



 

14.  You can change the color of each signal to help identify it in the chart by clicking on the Color column in 

the signal list with the mouse.  Do this to give each signal a unique color.  

15.  In the chart above, you can see the Mean Frequency values for both channels, but because the filter 

amplitudes are down in the microvolt range they can't be seen.  There are several ways to work around this. 

 One possibility would be to group signals with similar ranges in their own View.  For example you can create 

one View window for displaying mean frequencies, which typically range from 1-30Hz.  You could then add 

another View to display filter amplitudes, which typically range from 1 to 50 microvolts when looking at EEG 

signals.  

Another alternative is to enable and disable signals in the chart, using the Chart colum in the Signal List. 

 Uncheck the Chart box for both Mean Frequency signals, and the chart will rescale to display the filter 

amplitudes.  

A third alternative is to use the Scale value in the signal list.  The value entered here will be used to scale the 

displayed values.  First make sure that all four signals are enabled in the chart by checking them in the Chart 

column.  Then enter 1000000 in the Scale column for both Bandpass Filter Amplitude signals.  This allows you 

to view the mean frequency and amplitude on the same chart as shown below:  



 

16.  Save your report again by choosing Save from the Report menu.  

17.  You can now run this report on any session that contains at least two EEG channels, by choosing 'Run On 

Session' from the Report menu and choosing a session.  

  

  

  

  

  

  

  

  


